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1 An Introduction to WinIBW3 

1.1 Introduction 

This document describes the WinIBW3 product. 

WinIBW3 is Windows-based Intelligent Bibliographic Workstation created by OCLC, a versatile and effective 

tool that provides library staff access to both OCLC CBS and LBS systems.  

The intended audience for this document: 

• system administrators responsible for creating site-specific installations of WinIBW3,  
• writers of end user documentation, 
• testers of the WinIBW3 product. 

 

The language of this document is English. No translations into other languages are provided. All of the 

installation instructions and examples are based on the installation of an English-language operating system 

and application software. All commands are given in their language-independent forms, preceded by a 

backslash. Each site is responsible for the translation of the information in this document and the creation of 

end user documentation.  

1.2 Relevant Supplementary Documentation 

The following supplementary documentation is available 

• SetupStudio 3.0 User Manual, version 1.9, 18-11-2013. 

• Scripting in WinIBW3, version 1.18, 18-11-2013. 
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2 Getting Started With WinIBW3 

2.1 WinIBW3 Setup 

WinIBW3 is delivered in the form of a base distribution that is used to build customized, site-specific 

WinIBW3 setups. The details of the implementation of a site-specific installation are given in the document 

SetupStudio3 – User Manual. This document describes only the features and functionality of the WinIBW3 base 

distribution. 

The customized WinIBW3 setup program is used to install WinIBW3 on the user PCs. The installation 

procedure is fairly straightforward. The sites are also responsible for creating a localized installation, using 

and/or describing the defaults set in the specific setup. 

2.2 System Requirements 

WinIBW3 is supported on the following platforms: 

 

Operating System Version Disk Space Requirements 

Windows XP Professional All 100 MB 

Windows 2000 Professional All 100 MB 

Windows NT4 Latest service pack 100 MB 

Windows 98 Second Edition 100 MB 

Windows Vista  All 100 MB 

Windows 7  All 100 MB 

 

The main target systems are Windows XP and Windows 7. 

Windows 95 is unsupported. 

WinIBW3 does not contain explicit support for Terminal-Services enabled systems. We do not, however, 

expect any problems in TS-environments, since WinIBW3 no longer uses interprocess communication. 

2.3 Product Dependencies 

WinIBW3 can be installed in conjunction with an existing installation of WinIBW2, and can also be run 

simultaneously with it. However, previous installations of WinIBW3 must be removed. 

On Windows 98, ME and NT4, Internet Explorer 5 or later must be installed. 

Appropriate Input Method Editors and fonts must be installed. In particular, the Arial Unicode MS font must 

be installed. 

WinIBW3 must run in conjunction with CBS4 version 3.0 or later in order to allow the display and editing of 

bibliographic data in Unicode.  

2.4 Starting WinIBW3 

When WinIBW3 is started, the default start page is displayed. The start page is the only document that is 

stored locally; all other documents are retrieved from the remote system (CBS or LBS) that the user has 

connected to. 
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Note: When the default start page is not found, the message below will be displayed. If you click “OK”, 

WinIBW will be suspended, If you click the “X” button, WinIBW will continue to run and you can specify an 

alternative start page. 

 

 

 

WinIBW3 starts up using the default language setting defined in the WinIBW3 setup. As soon as the user logs 

in, the language is set to the value retrieved from the server, as specified in the user profile record. The 

language can also be changed by the user directly when working with WinIBW3 via one of the commands 

supported by the remote system. 

The startup screen usually contains one or more links to systems that the user can connect to by simply 

clicking on the link. The startup file is a normal HTML file. Links are standard anchor tags attached to text or 

an image. The link pointing to the remote system must be of the form 

 

pica3://<server>:<port>[-<port>] 

 

Example: 

<a href="pica3://cbs4.pica.nl:1035">CBS4 Production</a> 

The name and location of the startup file are set during creation of the WinIBW3 setup. The default location 

is resource:/chrome/ibw/content. 

The startup screen can be recalled by pressing Ctrl-N, or by selecting it from the list of recently used files 

under the File menu. Alternative startup files can be opened using the Open... function from the File menu. 

The user can select an alternative startup file to become the default startup file via the user preferences 

dialog. 

There is an alternative way for WinIBW3 to establish a connection with a remote system: in the command 

line, just enter the url to the remote system with the above mentioned link form. 

Example: pica3://cbs4.pica.nl:1035 

With the example url, WinIBW3 will start a connection with the GCC/NCC production system. 

2.5 Logging In 

WinIBW3 presents the Login screen after connection to a remote system has been established. 

This allows the user to enter a user ID and a password.  
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The user can bring up the Login screen at any time by issuing the login command \LOG. When the user ID 

and password are appended to the login command, the login screen is bypassed. 

The user can change the password using the \MUT \PAS command. 

2.6 System and Database Selection 

After the user has successfully logged in, WinIBW3 presents the System Selection screen. The screen 

contains two lists showing only the systems to which the user has access: 

• Internal systems 

The Database Selection dialog appears after a system is selected from one of the lists, showing the databases 

for which the user has access permission. When a default database is configured in the user profile record, 

this database is automatically selected, bypassing the Database Selection dialog. 

The system selection screen can be invoked directly via the \SYS command, and the database selection dialog 

can be invoked with the \BES command.  

The Home function in the toolbar (Ctrl-H) brings up a dialog box in which the available systems and 

databases are presented together in one list. 

WinIBW3 presents a welcome screen after a system and database have been selected; this screen optionally 

contains general information about the selected system and database. From this point on, all functions for 

searching, cataloging, ILL, user and library maintenance for which the user is authorized are available via the 

appropriate commands.  
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3 The WinIBW3 Interface 

The WinIBW3 User Interface consists of the following components: 

• Caption 

• Menu and Tool Bars 

• Command Bar 

• Special Characters Bar 

• Message Bar 

• Document Window 

• Button Bar 

• Status Bar 

The Document Window contains the button bar; when multiple windows are open, each one contains its own 

button bar. 

The Tool Bar, Command Line, Special Characters Bar, Status Bar and Message Bar can be enabled or disabled 

via checkable menu items in the View menu. However, the Message Bar will always reappear (be enabled) 

when WinIBW3 has a message to display. 

3.1 Caption 

The caption of the WinIBW3 application contains the sign for WinIBW3, the application name (e.g. “WinIBW 

3.0”) and the application title consisting of the following elements as default: 

• The system and database name,  

• The screen name (system selection, database selection, file information, history, short presentation, 

long presentation and title edition) in the Document Window. 

The application title of the WinIBW3 caption can also be configurable with the variables in the table 

‘Variable-ID and Variable Function’ presented below during creation of the WinIBW3 setup (see the 

documentation “SETUPSTUDIO 3.0 User Manual” for more about how to configure WinIBW3 caption). After 

a successful login, the customized caption will be active. 

Variable-ID Variable Function 

$CN$ CBS host name 

$SY$ System name 

$BE$ Database name 

$E07$ Screen name (system selection, database selection, file information, history, 

short presentation, long presentation and title edition). 

This variable is a part of a screen definition, not a ‘real’ variable. 

$PP$ PPN 

$UK$ User ID (User key) 

$UM$ User name 

$UL$ User library ID 

$UB$ User library name 
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The caption also contains the standard Windows buttons for minimizing, maximizing or restoring the 

previous format and closing the application. 

3.2 Menu Bars and Toolbars 

The Menu Bar and the Toolbar give the user access to the internal WinIBW3 functions. 

The default layout of the Menu Bar and Toolbar are defined as part of the WinIBW3 setup, and are stored in 

the file \defaults\pref\registry.xml. Please refer to the documentation “SETUPSTUDIO 3.0 User Manual” 

for a description of how to define the default settings for these user interface elements. 

Users can adjust the menus and button bars to their own preferences using the Customize dialog. These 

changes are stored in the user profile, in a process which will be described in more detail in Section 4. 

3.3 Standard Functions 

This section describes the complete set of standard functions in WinIBW3. These functions can be accessed 

via the menu, toolbars or shortcut keys. In the base distribution, the default menu and the main toolbar 

contain a selected subset of the standard functions. Users can change this configuration with the UI-

Configuration function. The same function is used by administrators to adapt the default configuration for 

localized site distributions. 

The following tables give an overview of the WinIBW3 functions that are listed in the UI Customization 

dialog, and that are available to build the main menu and toolbars. 

3.3.1 File Functions 

Function Description 

Start page Open the default startup document. 

Open Open an existing document, using a standard File Open dialog. This can be an 

alternative startup file, or an arbitrary HTML file. 

Close Close the active Document Window. 

Print Print the active document. This function is not always available, especially when 

the window contains a list control (such as the Short Presentation screen, or 

the Scan screen). 

Print Setup… Setup print settings. (This function is only available in standard UI, but not in 

the UI Customization dialog.) 

Print Preview Displays a print preview of the active document. 

Back Go to the previous screen for the active Document Window. 

Forward Go to the next screen for the active Document Window. 

Reload Reload the tile in the title ‘Update’ mode. 

Home Go to Home page. 

To search screen Switch to search screen. 

Previous Go to the previous title record within one set in the long presentation. 

Next Got to the next title record within one set in the long presentation. 

Download Download the selected title to the destination file. 

Exit Quit the WinIBW application. 

 

The WinIBW3 file menu also contains a list of recently opened files. 
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3.3.2 Edit Functions 

Undo Undo the last action. 

Redo Redo the previously undone action. 

Cut Cut the selection to the Clipboard (only in the editor). 

Copy Copy the selection to the Clipboard. 

Copy Plus Append the selection to the data on Clipboard. 

Copy PPN Copy a PPN to the Clipboard. 

Copy all Copy the entire content of the window to the Clipboard (This function 

performs first the function ‘Select all’, then the function ‘Copy’). 

Copy title Copy the bibliographic data in the current full presentation screen to the 

Clipboard.  

Note: The ‘Copy title’ function has to be used with the ‘Paste title’ function.  

Paste Insert the contents of the Clipboard. 

Paste title Paste the bibliographic data from the Clipboard, according to the TitleCopy 

Instructions file (see section 9.3 for more about the instruction file of 

TitleCopy function.) 

Select all Select the entire content of the window. 

Select none Unselect the entire content of the window. 

Find… Find the specified text in the editor. 

Find again Repeat find in the editor. 

Find / Replace… Replace specific text with different text in the editor. 

Goto Line… Go to line number in the editor. 

Table… Activate the Table function. 

Spell Check Enable or disable spell check and auto-complete functions. 

Add Word Add the selected word to your dictionary for spell check and auto-complete. 

Specify tags for spell check Specify tags on which spell check takes place. 

Change dictionary for spell 

check and auto-complete 

Change dictionary used for spell check and auto-complete. 

RTL Enable right to left writing (RTL). 

3.3.3 View Functions 

Toolbar Show or hide the image toolbar 

Command Line Show or hide the Command Line 

Special characters Show or hide the special characters toolbar 

Status Bar Show or hide the Status Bar 

Message Bar Show or hide the Message Bar 

Source Show HTML source code 

Trace Show or hide trace messages 

3.3.4 Options Functions 

Preferences… Change user preferences 

Customize… Customize toolbar, menu and shortcuts 

Tables… Create and edit tables for the Table Function 

3.3.5 Transliteration Functions 

All the functions in this section are only available in the title ‘Insert’ and ‘Update’ mode. 
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Setup transliterate… Setup (configure) and perform transliterate process. 

Repeat transliterate Repeat transliteration process with the configured data’s. 

Setup adding serial number 

and  script code…  

Setup (configure) and perform adding serial number and script code process. 

Repeat adding serial 

number and  script code 

Repeat adding serial number and script code process with the configured 

data’s. 

3.3.6 Script Functions 

Edit script Open WinIBW3 embedded scripting IDE.  

Add a script function Add a user script function. 

Start script recording Start the script recording i.e. set the user script recording mode ‘On’. 

Stop script recording Stop the script recording i.e. set the user script recording mode ‘Off’.  

Start script engine Start the Script Engine for user scripts of the specified scripting language. 

Stop script engine Stop the Script Engine for user scripts of the specified scripting language. 

Resume script execution Resume the paused user script execution to continue running. The execution 

of a user script function can be paused by calling the function ‘pauseScript’ 

from user scripts.  

3.3.7 Mail Functions 

All View all Pica-mail 

Organisation View organisation mail 

Personal View personal mail 

Send Send Pica-mail 

Sent View mail sent by the user 

System View system mail 

3.3.8 Window Functions 

Arrange Icons Arrange icons at the button of the window 

Cascade Arrange windows with overlapping. 

Close All Close all windows. 

New Open a new window. 

Tile Horizontal Arrange windows horizontally with a non-overlapping tile. 

Tile Vertical Arrange windows vertically with a non-overlapping tile. 

3.3.9 Special functions 

Function name Short-cut Description 

Title.DeleteSelection  Delete the currently selected text in 
the title editor. 

Title.DeleteToEndOfLine  Delete the text from the cursor 
position to the end of the line in the 
title editor. 

Title.DeleteLine Ctrl+Y Delete the current line in the title 
editor. 

Title.DeleteWord  Delete the current word in the title 
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editor. 

Title.JoinLines  Join the current line with the following 
line in the title editor. 

PicaButton1 Ctrl+1 Press the first button on the button 
bar in a document window. 

PicaButton2 Ctrl+2 Press the second button on the button 
bar in a document window. 

PicaButton3 Ctrl+3 Press the third button on the button 
bar in a document window. 

PicaButton4 Ctrl+4 Press the fourth button on the button 
bar in a document window. 

PicaButton5 Ctrl+5 Press the fifth button on the button 
bar in a document window. 

PicaButton6 Ctrl+6 Press the sixth button on the button 
bar in a document window. 

PicaButton7 Ctrl+7 Press the seventh button on the 
button bar in a document window. 

PicaButton8 Ctrl+8 Press the eighth button on the button 
bar in a document window. 

PicaButton9 Ctrl+9 Press the ninth button on the button 
bar in a document window. 

ReloadStandardScripts Ctrl+Shift+Alt+R Reload all standard scripts. 

ClearScreenCache Ctrl+Alt+Enter Clear the screen cache. 

ReloadDiacritics Ctrl+Shift+Alt+D Reload the diacrtics bar. 

RestartWinIBW3WithDefaultGUI Ctrl+Shift+Alt+S Restart WinIBW3 with the default 
GUI. 

RestartWinIBW3WithUserGUI Ctrl+Shift+Alt+U Restart WinIBW3 with the user GUI in 
user-profile location. 

FocusCommandLine Alt+C Bring the focus to the command line. 

FocusView Alt+I Bring the focus to a document view.  

FocusListControl Alt+L Bring the focus to the list control. 

 

When pressing one of the short-cut´s in the table above, the corresponding function will be 
executed. If no short-cut is defined for a function in the table above, the function can be invoked by 
using the way in which a standard script function is invoked, see section 8.3.2 for more details about 
how to invoke a standard script function.  



 

project:  

document name: WinIBW3 Product Description 

version: 2.7 

 

  

Date 18-11-2013 page 18 of 126 

 

3.3.10 Help Functions 

About WinIBW Display About box 

Cataloging help Help for cataloging rules 

ILL Document Document for Library Information Delivery Service 

Info Shows information about WinIBW3, credits and license information about 

third-party software. 

3.3.11 Main Tool Bar Functions 

Start page Open the default startup document. 

About WinIBW3 Display About box. 

Back Go to the previous screen for the active Document Window. 

Cataloging Rules Help for cataloging rules 

Change material type Change material type for Coded Data screen. 

Copy Copy the selection to the Clipboard. 

Cut Cut the selection to the Clipboard. 

Forward Go to the next screen for the active Document Window. 

Home Go to Home page. 

Next Got to the next title record within one set in the long presentation. 

Open document Open an existing document, using a standard File Open dialog. This can be an 

alternative startup file, or an arbitrary HTML file. 

Paste Insert the contents of Clipboard. 

Find Find the specified text in the editor. 

Previous Go to the previous title record within one set in the long presentation. 

Print Print the active document. This function is not always available, especially when 

the window contains a list control (such as the Short Presentation screen, or 

the Scan screen). 

Reload Reload the tile in the title ‘Update’ mode. 

Save document Save the current document 

Show/Hide Coded Data Enable or disable Coded Data 

Novice Mode Enable or disable Novice Mode 

View all mail View all Pica-mail 

View personal mail View personal mail 

To search screen Switch to search screen after one database is selected. 

3.4 Command Bar 

The Command Bar is a dockable control interface used to enter commands that WinIBW3 then sends to the 

CBS or LBS. The Command Bar contains a Command Line and a History List. 

The Command Bar can be detached to a floating window on the screen, or be docked in the upper or lower 

part of the main application window. The default position is at the bottom of the client area of the window, 

directly below the button bar.  The detached Command Bar can be dragged around onscreen using the 

mouse. 

The Command Bar is automatically resized when it is docked to fit the width of the application window, 

either alone, or together with another existing control bar.  
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A floating Command Bar's width can be changed. The height of the Command Line depends on the point size 

of the current typeface. WinIBW3 remembers the size and position of the Command Bar when it is closed or 

docked, and restores the size and position when it activated or detached again. 

 WinIBW3 also remembers the size and position of the Command Bar between sessions, and restores that 

status when WinIBW3 is started. 

The Command Bar can be hidden or shown via a checkable menu item. When the Command Bar is hidden, it 

takes the focus and appears again as soon as the user presses a key that is not processed by any other control 

on the screen. 

WinIBW3 remembers whether the Command Bar was activated or not between subsequent sessions. The 

Command Bar's state (floating or docked) is also preserved between sessions. 

3.4.1 Command Line 

The Command Line is a single-line text editing control, used to type commands. Standard basic editing 

functions such as Copy and Paste, etc. are available. A right-click in the Command Line will summon a context 

menu offering the standard editing functions Undo, Redo, Cut, Copy, Paste, Delete and Select All. 

The Command Line has an auto-completion feature that can be used in conjunction with the History List to 

quickly reissue commands. When auto-completion is not wanted, the extra text can be removed by pressing 

the Escape key, the Backspace key or the Delete key. Auto-completion cannot be disabled at this time. 

The command entered by the user is processed by WinIBW3 when the user presses Enter or Return. The 

contents is removed from the Command Line, and added to the History List. Focus moves to the control 

indicated in the template/screen definition. 

The focus can be moved to the Command Line from any location by pressing Alt-C.  

3.4.2 History List 

The History List contains a list of all previously issued commands, deduplicated, and sorted in reverse 

chronological order. 

It can be invoked by starting to type a command. Only commands in the list that match the text already typed 

are shown. With the Up-Arrow and Down-Arrow keys or with the mouse an item from the list can be 

selected. When Enter is pressed, the command is immediately executed. When the item is selected with a 

mouse click, the Enter key must be pressed to execute the command. 

When the Command Line is still empty, the History List can be invoked by pressing the Up-Arrow or Down-

Arrow key. In that case, all available items in the History List are shown. 

Pressing the Escape key will close the History List. 

The command history is retained between different WinIBW3 sessions. The list of commands is stored in the 

user preferences file. The maximum number of entries in the History List is set via a parameter when creating 

the WinIBW3 setup. The switching between displaying the command line history and no-displaying the 

command line history and the maximum number of entries in the History List to be displayed can also be 

done within WinIBW3, see section 4.1.2.1 4.1.2.1for more information about how to do it.  
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3.4.3 Font Settings 

The default font settings for displaying characters on the Command Line, including font, size, colour and style, 

are stored in the file \defaults\pref\ibw_prefs.js during WinIBW3 setup. The font settings can be changed 

via the User Preferences dialog and stored in the user profile. 

Every time when WinIBW3 starts up, the default font settings are applied. If a user-specified font size is 

available in the user profile, the command line bar will be adapted to the user-specified font size after 

pressing up-key or down-key. If there is no user-specified font size in the user profile and then a user 

specifies one, the command line bar will be adapted to the user-specified font size after pressing up-key or 

down-key. Afterwards, every time when the font size is changed, the command line bar will be automatically 

adapted to the user-specified font size (without pressing up-key or down-key). Note: when the display of the 

command history is distorted, press "Ctrl+Shift+Alt+S" to restart WinIBW3 without leaving WinIBW3. The 

command line bar will be always for the user-specified font size after pressing up-key or down-key. 

The History List takes always the default font size for the Command Line. 

3.5 Message Bar 

The Message Bar displays messages that are posted from one of the following three sources: 

• messages received from the CBS or LBS 

• messages issued by WinIBW3 itself 

• messages from standard or user-defined scripts 

A CBS message will be one of the following types:  

• Notification (M01) 

• Warning (M02) 

• Error message (M03) 

Messages are shown in either a modal popup window, on the Message Bar, or both. The default behavior is 

specified when creating the WinIBW3 setup with SetupStudio, and can be adapted for personal settings with 

the User Preferences dialog box. It is not possible to disable both means of displaying messages 

simultaneously. The settings can be different for each of the three types of messages. 

A message first appears in a modal popup window (one for each consecutive message). After the user has 

discarded the popup windows, the messages are displayed in the Message Bar (all collected within a single 

Message Bar).  

The type of the message is indicated with an icon displayed to the left of the message text.  

Messages have a maximum length. If this length is exceeded, the text is truncated, indicated by the use of an 

ellipsis at the end of the text. 

The Message Bar is shown only when there is a message to be shown, When the window changes (for 

example to display the results of another command) and there is no message, the Message Bar is 

automatically hidden. 

The Message Bar is a dockable control that can be detached to a floating window on the screen or docked in 

the upper or lower part of the window. Its default position is at the top of the client area of the window, 

directly below the button bar, but it can be moved to a different position using the mouse. 
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The Message Bar's width can be changed while it is floating. WinIBW3 remembers the size and position of the 

Message Bar when it is closed or docked, and restores the size and position when it activated or made 

floating again. WinIBW3 also remembers the size and position of the Message Bar between sessions, and 

restores the status when WinIBW3 is started. The height is automatically adjusted to the number of messages 

to be displayed. Each message is displayed in one line. 

The Message Bar can be made visible or hidden via a checkable menu item in the View menu. When the 

Message Bar is floating, it can be closed with the x-button on the caption. 

3.5.1 Font Settings 

The default font settings for the Message Bar are stored in the file \defaults\pref\ibw_prefs.js, and can be 

set when creating the WinIBW3 setup. 

The typeface and point size used for displaying the characters in the Message Bar can be changed by the user 

via the User Preferences dialog.  

The font settings for the popup dialog boxes cannot be changed in WinIBW3. Their appearance can be 

changed by a general setting in the Window interface. 

3.6 Special Characters Bar 

The Special Characters Bar displays the special characters which can be entered at the cursor in the 

Command Line or in the Title Edit Control by means of left mouse single-click on a wanted character when 

the dialog ‘Options\Customize...\Customize’ is open. 

The font, size and style of the special characters on the Special Characters Bar are fixed. As default, the order 

of these special characters on the Special Characters Bar is defined by the file ‘diacritics.js’ in the directory 

‘defaults\pref’ under WinIBW3 installation and the legends for these special characters is defined by the file 

‘diacritics_description_xx.js’ in the same directory, where xx is the language indication. (Therefore, the file 

‘diacritics_description_xx.js’ is country dependant, i.e. each country has its own ‘diacritics_description_xx.js’, 

e.g. the file ‘diacritics_description_ne.js’ is used for a Dutch configuration and  the file 

‘diacritics_description_fr.js’ for a French configuration. Which ‘diacritics_description_xx.js’ to be used is 

made at WinIBW3 setup.) However, the order of these special characters can be rearranged by a user by 

dragging a special character to the wanted position on the Special Characters Bar. The updated order will be 

saved under user profiles when WinIBW3 is closed. When WinIBW3 is restarted, the updated order will be 

used. If the user wants to use the default order and legend again, he\she can press the shortcut key 

‘Ctrl+Shift+Alt+D’ to reload the file ‘diacritics.js’ and ‘diacritics_description_xx.js’. 

The Special Characters Bar is a dockable control which can be detached to a floating window on the screen 

or docked in the upper or lower part of the window. The default position is at the top of the client area of 

the window, directly below the button bar. It can be moved around using the mouse. 

The Special Characters Bar can be made visible or hidden via a checkable menu item in the View menu, and 

optionally with a shortcut key determined when creating the WinIBW3 setup. Ctrl-D is historically used for 

this purpose. When the Special Characters Bar is floating, it can be closed with the x-button on the caption. 

3.7 Status Bar 

The Status Bar is used to show additional information for menu items, or the URL behind a link when the 

mouse pointer is moved over the link in a presentation screen. 
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The Status Bar also contains indicators for Caps Lock, Num Lock and the Insert / Overwrite mode of the 

Title Edit Control. 

The timer indicating how long it takes for a command to be processed has not been implemented in 

WinIBW3. 

The Status Bar can be made visible or hidden via a checkable menu item in the View menu. Its position, size 

and font settings cannot be changed. 

3.8 Document Window 

The Document Window is used to display the results of commands, such as search commands, presentation 

commands, cataloging commands etc. The data displayed is provided by the remote system (CBS or LBS), 

except for the start page that WinIBW3 displays at startup. 

3.8.1 Connection and Context 

After making a connection to a remote system, logging in and selecting a database, the user can issue 

commands. Apart from the commands that are sent from WinIBW3 to the remote system and the results of 

those commands that are returned, additional information is exchanged in the form of context variables. 

WinIBW3 remembers certain context variables in the context. Examples of context variables are: 

- Set size and current selected item in short presentations 

- Language 

- Current presentation and / or cataloging format 

- Current PPN 

3.8.2 Multiple Document Windows and Connections 

It is possible to open more than one Document Window. New windows inherit the context from windows 

that are already open, except when a new connection is established. When a new window is opened, and the 

user logs in again, or changes the selected database, this applies to the other windows as well.  

When the user wishes to use different databases simultaneously in separate windows, or to log in with 

separate user accounts in different windows, it is necessary to establish separate connections via the start 

page. The easiest way to do this is to open the start page from the File menu (which opens a new window 

automatically) and make a connection to the desired system. The login account can be the same or different 

when using the same connection as before, and the database can also be the same or different as before. 

From that moment on, the two windows will run in separate contexts.  

3.8.3 Organizing Document Windows 

Standard Windows functionality is provided to maximize or minimize the document subwindows within the 

main application window. When one Document Window is maximized, all windows are maximized. 

Maximized windows are automatically resized when the application window changes size, or when other 

components (such as the Message Bar etc.) (dis-)appear or change size. 

An not maximized Document Window can have a user-determined size. In that case, the Document Windows 

are no longer automatically resized. 

Each Document Window can individually be closed via the Close button. 
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The Window menu offers the following functions for manipulating the Document Windows: 

• New 

• Cascade 

• Tile horizontal 

• Tile vertical 

• Arrange 

• Close all 

3.8.4 HTML Pages 

WinIBW3 can display HTML pages (e.g. the start page) directly. However when an HTTP link is clicked, 

WinIBW3 will open the system's standard browser to display the new page. 
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4 Adjustments to WinIBW3 

There are two different ways for a user to adjust WinIBW3 to his/her own wishes: 

• User Preferences 

• Customization of the User Interface. 

Note that it may be possible to change settings in the online system that WinIBW3 connects to as well, but 

that this has nothing to do with WinIBW3 (cf. the Show Parameters (\TOO \PAR) command). 

4.1 User Preferences 

The User Preferences dialog is called up via the Options menu. The dialog contains four pages that can be 

selected with the buttons on the left of the dialog box. These pages are: 

• General1 

• General2 

• Fonts and Colors 

• Messages 

A file location must be specified for several settings. This location must be a valid URL. When a file under the 

WinIBW3 installation directory is used, the URL can start with resource: such as  

resource:/chrome/ibw/content/start.htm 

When a file in a different location on the computer is specified, the URL should be of the form 

 file:///<full file pathname> 

In certain situations a file located on a web server can also be specified, such as for the start page or the 

TitleCopy file. 

4.1.1 General Settings 1 

On the page General Settings 1 in the User Preferences dialog box, the following items can be set: 

• Start page 

• Download destination 

• User-defined TitleCopy instructions file  

• Flag specifying whether WinIBW3 should open a new window when issuing a command from the Edit 

Screen. 

• Flag specifying whether the WinIBW3 internal data cache is enabled or disabled. 
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Note that all printer settings have now been moved to the function Printer Settings in the File menu, where 

settings for different printing types can be specified. 

4.1.1.1 Start Page 

This specifies the URL of the page that WinIBW3 opens when starting up. The start page can be selected 

using the Browse... button to open a standard dialog box, or the URL of the start page can be typed in. 

4.1.1.2 Download Destination 

The name of the download destination file can be set by selecting Download from the File Type list box, 

typing the URL of the download destination file in the Location field, or entering a name in the Location field 

by one of the following 2 ways:  

• An existing file can be used as the download destination file by using the Browse... button 
to open a standard ‘Open’ dialog box and selecting the wanted one.  

• A new download destination file can be created by using the Save As… button to open a 
standard ‘Save As’ dialog box, typing the wanted file name in the ‘File name’ field and press 
the ‘Save’ button. The new download destination file will be created only after using the 
menu command File | Download. 

 

When the check box Print is checked, the output of the download command is not stored in a file, but 

instead printed on the default printer. 
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4.1.1.3 TitleCopy Instructions File Location and Name 

The location and name of the default TitleCopy instructions file can be set during creation of the WinIBW 

setup (see the documentation “SETUPSTUDIO 3.0 User Manual” for more about it) and stored in the setup.js 

file as a preference .e.g.: 

pref("winibw.filelocation.titlecopy ", "resource:/scripts/title.ttl").  

The location and name of the default TitleCopy instructions file can also be set or changed by setting the 

preference "winibw.filelocation.titlecopy" in the ‘ibw_prefs.js’ file, e.g. pref("winibw.filelocation.titlecopy", 

"resource:/scripts/title.ttl"). 

The location and name of the user-defined TitleCopy instructions file can be set by selecting Title copy from 

the File Type list box, and typing the URL of the instructions file in the Location field or entering a name by 

using the Browse... button to open a standard ‘Open’ dialog box. The file specified here must already exist. 

The user-defined TitleCopy instructions file will overwrite the default one. When the location field for the 

File Type Title copy is empty, i.e. the user-defined TitleCopy instructions file is not provided here, the 

default TitleCopy instructions file will be used. Therefore, in the Location field for TitleCopy there is always a 

TitleCopy instructions file visible, which is either the default one or user-defined one. 

4.1.1.4 Executing Commands Issued While Editing In a Separate Window 

Normally commands are executed in the currently open window, replacing the contents of the window with 

the result of the command. However, while editing bibliographic data it is often desirable to issue a command 

without interrupting the edit process. WinIBW3 is able to automatically open a new window for commands 

issued during editing, and display the results in the new window. The edit process continues in the original 

window, and the user can switch back to this window or close the new window to continue cataloging. 

This feature can be enabled or disabled by checking or un-checking the checkbox Execute commands in 

separate window when editing. 

4.1.1.5 Disable the usage of WinIBW3 internal data cache 

By default, WinIBW3 internal data cache is enabled.  However, sometimes WinIBW3 users would like to 

disable (temporarily) WinIBW3 internal data cache mechanism for some reasons. The internal data cache can 

be disabled/enabled within WinIBW3 via the checkbox ‘Data cache disable/enable’ in the menu dialog 

‘Options\Preferences\General1’.  The checkbox is unchecked by default. When the box is checked, data from 

CBS will not be cached in WinIBW3. When the box is unchecked, the WinIBW3 data cache will function 

again. 

4.1.2 General Settings 2 

On the page General Settings 2 in the User Preferences dialog box, the following groups can be found: 

• Command line history:  The history of the used commands in the command line is kept in the History 

List of WinIBW3, see section 3.4.2 for more about it. 

In this group, display command line history can be specified and clean up command line history can be 

performed. 

• Update service: In this group, the OCLC URL is provided. The being used URL for update service is 

shown and can be reset. Besides, the last update date is shown and can be reset. With a correct URL 

and an older date, update can be done at anytime within WinIBW3.  
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4.1.2.1 Display Command Line History 

When the checkbox ‘Display command line history’ is checked and the ‘Command line history display size’ 

field is specified with a number, a specific number of the last used commands will be displayed. The maximum 

number that can be set is 200. In case that the ‘Command line history display size’ field is empty or set to 0, 

no used command will be displayed.  

When the checkbox ‘Display command line history’ is not checked, the ‘Command line history display size’ 

field is disabled. In that case, no used commands will be displayed.  

When the ‘OK’ button in this page is pressed, the new settings will be saved in the ‘user_pref.js’ file and then 

WinIBW3 can work with them without the requirement of being closed and restarted again.  Therefore, this 

feature can be random set during the use of WinIBW3. 

4.1.2.2 Clean Up Command Line History 

When the button ‘Clean up’ is pressed, a message box with the message ‘Clean up command line history is 

successful’ will be shown. Then, the History List will be empty, i.e. with the Up-Arrow and Down-Arrow keys 

nothing will be shown in the command line. Besides, the updated History List will be saved in the 

‘user_pref.js’ file when closing WinIBW3 so that the command line keep clear with the Up-Arrow and Down-

Arrow keys at next WinIBW3 start-up. 

4.1.2.3 Update service address 

Please, read section 9.9 first for more information about Update Service and Update specification file. 
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Update service address is the web server location where the source files for update and the update 

specification file “update.xml” reside.  

The read-only text box ‘OCLC URL’ of the sub-group ‘Update service address’ in the group ‘Update service’, 

is the address used by OCLC to perform updates worldwide. 

The text box ‘URL’ is the address to perform update service in WinIBW3, which can be configured at 

WinIBW3 setup and changed in WinIBW3 to perform site, library or group specific updates. The latter makes 

it possible that users are able to perform different updates without a new WinIBW3 setup. When this 

address is the address at ‘OCLC URL’, the updates made by OCLC will be performed.  

The address at ‘URL’ is the value of preference "ibw.updateservice.url". See the section “Update 

Service” of the document “SetupStudio 3.0 – User Manual.doc” about how to configure this address at a 

WinIBW3 setup. 

4.1.2.4 Performing Update within WinIBW3 

Please, read section 9.9 first for more information about Update Service and Update at WinIBW3 start-up. 

The update is normally processed once a day during WinIBW3 start-up. If no update takes place or update is 

unsuccessful, the functionality provided in the group ‘Update service’ can be used after problems outside 

WinIBW3 are fixed. 

The textbox ‘The last update date’ shows the date of the last update, which is the value of the preference 

"ibw.updateservice.lastdate". The value of the preference "ibw.updateservice.lastdate" 

and the date in the textbox ‘the last update date’ will be updated with the date at which a successful update 

takes place. 

The date of the last update can be reset to a date which is earlier than the value of the date item of the 

<update> element in the update specification file “update.xml” described in section Error! Reference 

source not found., by selecting a year, a month and a day respectively in the year, month and day list-box, 

and pressing the button ‘reset’. After every resetting, the value of the preference 

"ibw.updateservice.lastdate" and the date in the textbox ‘the last update date’ are updated.    

With an earlier date of the last update, one of the following 2 ways can be used to re-enable the failure 

update: 

• Press the button ‘Update now’ and the update will be done immediately within WinIBW3. 

• Close WinBW3 and restart it again. The update will be done once a day at WinIBW3  

      start-up. 

When update fails, a update report with a list of all unsuccessful files for update will be shown, followed by a 

message indicating a failure update in case the checkbox ‘Display a failure update service’ is checked. If the 

checkbox is unchecked, the message will not be shown, which is set as a default.   

4.1.3 Fonts and Colors 

On the Fonts and Colors tab, the user can set the typeface, point size, color and style of the text for several 

user interface objects: 

• Full Presentation screens 

• Short presentation screens 

• Deduplication screen 
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• Edit Screen 

• Message Bar 

• Button Bar 

• Command Line 

 

 

 

The settings can be adjusted by first selecting the screen object from the list box Screen object. For this 

object the typeface can be selected from the list of available typefaces on the system, together with a desired 

point size. The text color can also be selected from a color palette, and one of four text styles can be 

selected (regular, bold, italic or bold and italic). The results are shown immediately in the example text box. 

Note: Only with font ‘Calibri’ can diacritic trema be correctly displayed, e.g in the title editor, on the 

command line. 

In the following sub-sections, all of the user interface objects will be described in more details with each per 

sub-section.  

4.1.3.1 Full Presentation Screen 

In addition to the text color it is possible to set the background color for Full Presentation screens. Since the 

Full Presentation screens always contain a default color (which is not available in the color palette for the 

background color), it is possible turn the use of the background color selected here on or off. When this is 

turned off, the default background color of the screens will be used. 
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Note that the settings for the Full Presentation screen also apply for a large number of other screens that 

only display information, such as show and update user and library information, ILL screens and even parts of 

the short presentation and edit screens. 

Note also that screens supplied by the remote system may contain font settings that override the user 

preference settings, and will thus remain unchanged. 

4.1.3.2 Short Presentation Screen 

The settings for the short presentation screen apply only to the list control in this screen. The settings for 

the Full Presentation apply to the text around the list control.  

The background color for the short presentation can also be set, in a similar fashion to the Full Presentation. 

When the typeface size of the short presentation list control is changed, the height of the lines in the list 

remains unaffected. For this reason, the typeface size should not be set to a very high value because this will 

cause the lines to overlap each other. 

The settings for the short presentation also affect the appearance of the History screen, and other lists, such 

as on the ILL screens. The Scan screen is unaffected. 

4.1.3.3 Edit Screen 

The settings for the short presentation screen apply only to the title edit control in this screen. The settings 

for the Full Presentation apply to the text around the title edit control.  

The background color for the edit screen can also be set, in a similar fashion to the Full Presentation. 

The appearance of the text in the title edit control is further affected by the settings for syntax coloring. 

These settings overrule the settings for the font color, and cannot be changed via the user preferences dialog. 

4.1.3.4 Deduplication Screen 
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The background color for full presentation screen is used as default for deduplication screen. The background 

color of a deduplication screen can not be set. Besides that the typeface, point size and style of the text can 

be set, the color for the different and similar texts can be also respectively set.  

4.1.4 Messages 

The user can specify how messages are displayed via the Messages page. 

WinIBW3 has three different types of messages: 

• Notification 

• Warning 

• Error message 

Each of the three types can be displayed either in the Message Bar (see also section 3.5), or in a pop-up dialog 

box (or both). It is not possible to disable both methods because that would result in messages never being 

displayed. 
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4.1.5 Storage of the User Preferences 

A separate set of files with profile settings is saved for each user using WinIBW3. These files are stored in the 

subdirectory \Profiles\<username> under the WinIBW3 application directory, where <username> is the 

network login name, or, alternatively, in a subdirectory under the user’s standard Documents and Settings 

directory. 

The user preferences are stored in the file user_prefs.js. This is a readable text file, which apart from the 

user preferences also contains the current Command History List, printer settings and Coded Data settings.  

If this file is deleted or otherwise inaccessible, the default user settings will be applied. 

4.2 Customization of the User Interface 

As the name implies, the Customize function can be used to customize parts of the WinIBW3 user interface 

such as the menus and toolbars, and shortcut key assignments. The possibility of incorporating one's own 

scripts into the user interface is particularly useful.  

The Customize function is also used extensively by administrators to customize site specific setups of 

WinIBW3. This aspect is described in the SetupStudio3 User Manual. 

All User Interface customizations are stored in the file registry.xml, located in the User Profile. The settings 

in this file will override any settings in the file with the same name in the directory \defaults\pref, which 

contains the default settings of the user interface and is created during the installation of WinIBW3. This file 

contains binairy data, and is not intended for direct modification. If the registry.xml in the User Profile is 

deleted, then WinIBW3 will of course revert to the default settings. 
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The Customization dialog box is accessed via the item Customize... in the Options menu. The dialog 

contains four pages, accessible via the tabs Commands, Toolbars, Keyboard and Menu. Furthermore it is 

possible to reset the customization to the last saved situation, or to the installation defaults. Each of the 

pages is described in the following sections. 

4.2.1 Commands 

The dialog pictured below shows the list of the Command categories available (corresponding to the list in 

section 3.3) in the pane at the left, and the available functions for the selected category on the right pane. For 

each category the first item in the list of commands represents a complete menu containing all functions of 

that category. This item can be used to add entire menus to the Menu Bar or Toolbar. 

 

 

The category Standard Functions shows the available standard script functions. The category Functions 

shows all available user defined scripts. The category All Commands shows all available functions. All the 

functions in the field under “Commands” are listed in alphabetical order. 

4.2.1.1 Adding and Removing Commands 

Commands can be added to an existing Menu Bar or toolbar in the following way: 

• Click on the command in the list of commands and keep the mouse button pressed down. The 

mouse cursor changes shape indicating that the selected item can now be dragged to the Menu Bar 

or toolbar. 

• Drag the selected item to the Menu Bar or toolbar. When the mouse cursor is moved over a Menu 

Bar, the submenu under the cursor unfolds. When the mouse cursor moves over a location where 
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the selected item can be inserted, an insertion cursor appears, in the Menu Bar itself, or in the 

submenu. 

• Release the mouse button, and the selected item is inserted in the menu at the location of the 

insertion cursor. 

Inserting items into a toolbar is very similar. Note that the toolbars can contain buttons that act as a 

submenu, indicated by a little arrowhead at the right end of the toolbar button. 

Existing menu items or toolbar buttons can be moved to another position by dragging the element to the new 

position. It is possible to move elements to another Menu Bar or toolbar, even to move an element from a 

Menu Bar to a toolbar, and vice-versa. 

Existing menu items or toolbar buttons can be removed by dragging the element away from the Menu Bar or 

toolbar. The mouse cursor changes shape and shows a little X, indicating that the element being dragged will 

be deleted when the mouse button is released. 

An element can also be removed by clicking on the element with the right mouse button; a context menu will 

appear, containing an option to delete the selected object. 

4.2.1.2 Changing the Appearance of Menu Items and Buttons 

After a command is inserted in a Menu Bar or toolbar, the dialog box appears that allows the user to adjust 

the appearance of the menu item or button. 

 

 

 

It is possible to display an image, text, or both. When an image is to be displayed, it is possible to choose the 

default image associated with the function, or to select a new image from a list. "Fanatical" users can even 

create new images, or edit existing ones. 

It is also possible to define a keyboard shortcut for a menu item which can be used for quick access to the 

menu item's function. In such cases, an ampersand “&” must be placed in front of the character that will be 

used as shortcut key. This can be any character in the text, not necessarily the first character. The selected 

character will appear underlined in the menu. For example, the text of the File menu is “&File”. Note that all 

shortcut keys in a given menu or submenu should be unique.  
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The appearance of menu items can also be set to Image and text, in which case the associated image will be 

displayed to the left of the menu item (see, for example, the Open item in the File menu). 

In the case of buttons on a toolbar, the text entered will be displayed as a tooltip. It is often practical to set 

the appearance of a toolbar button to Image and text at first, enter a suitable tooltip text, and then change 

the appearance to Image only. 

The dialog for the appearance of menu items and buttons is also accessible via the context menu that appears 

when an element is right-clicked. It is also possible to select Start group from this context menu, which will 

result in a dividing line being displayed directly above or to the left of the element. 

4.2.2 Toolbars 

New toolbars and Menu Bars can be created via the second tab of the Customization dialog. 

 

 

 

 

The Toolbars list contains three items which, by default, cannot be deleted or renamed. These are the default 

main menu, default toolbar, and a menu for the Print Preview window. 

A new Menu Bar or toolbar can be created using the New... button. After a name is entered, an empty 

toolbar will appear, floating above the dialog box. The toolbar can be docked by dragging it to the area where 

the other toolbars are located. Note that the title of the toolbar only appears when the toolbar is detached. 

Clicking on the Commands tab will enable the user to populate the toolbar with buttons and/or menu 

items.  
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The user can also specify whether tooltips are to be shown when the mouse cursor moves over the items on 

a bar, and whether shortcut keys are to be included in the tooltips (if present). These settings apply to all 

Menu Bars and toolbars. 

If the checkbox in front of the name of the toolbar is not checked, then this toolbar is hidden from the user. 

The toolbar will be shown again if the checkbox is checked. 

Toolbars created by the user can be renamed by first selecting the toolbar in the list and then pressing the 

button Rename...  

A selected toolbar can be completely removed from the user interface with the Delete button. 

4.2.3 Keyboard 

The third tab of the Customize dialog is Keyboard, which permits the configuration of keyboard shortcut 

keys that can be associated with functions. 

 

 

 

A Category can be selected in a drop down selection box at the left side of the dialog followed by one of the 

Commands in that category. An existing keyboard shortcut will be displayed in the box Current Keys, and a 

new shortcut can be added by clicking in the field under Press New Shortcut Key and pressing the desired 

key or key combination on the keyboard. WinIBW3 will show if the given key or combination has already 

been assigned for something else. If that is the case, then the key or key combination cannot be assigned (the 

button Assign remains grayed out).  If the key is not yet assigned, it can be assigned to the selected function 

by pressing the button Assign. More than one shortcut can be assigned to the same function. All individual 

numbers: 0-9, individual letters: a-z, A-Z, and any of the following characters: ~!@#$%^&*()_+{}:"|<>?|`-
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=[];'\,./ are not allowed to be assigned to a short-cut. When a number or a letter or a character mentioned 

above is pressed in the field under Press New Shortcut Key, the message “This number is not allowed” or 

“This character is not allowed” will be shown under this field, respectively. Besides, the button Assign 

remains grayed out. 

Assigned keys can be removed by selecting the key in the list Current Keys and pressing the Remove button. 

Shortcuts are shown in menus and tooltips of toolbar buttons. If there is more than one shortcut assigned to 

a given function, then only the first one assigned is shown in a tooltip. 

4.2.4 Menu 

The fourth tab of the Customize dialog displays the menus used in WinIBW3, and shows in principle two 

menus: Default Menu and WinIBW Document. The first is the normal WinIBW3 main menu; the second 

is only shown when no document windows are open. 

 

 

 

In this dialog it is possible to set options for the menu animations. Possible options are: None, Unfold or 

Slide. This setting applies to all available menus. 

4.2.5 Reset Customization 

The Customize dialog contains a Reset All button. After this button is pressed, a dialog appears that allows 

the user to reset the user interface configuration to the last saved configuration, or to the standard user 

interface configuration of the standard initial WinIBW3 installation. 
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A checkbox is provided in the dialog to allow have WinIBW3 restarted automatically after configuration is 

reset. 
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5 Presentation Screens 

5.1 Full Presentations 

Full Presentations is a term referring not only to the screens displayed by WinIBW3 showing single 

bibliographic records in the selected presentation format, but also screens that show user data, library 

information, ILL screens etc. Full Presentation screens even can contain input fields, lists and edit controls for 

cataloging bibliographic data. Some of the features of the lists and edit control are described in more detail in 

later sections. 

The structure of these screens (as of most other screens in WinIBW3) is defined in so-called screen and 

template files of the remote system (CBS or LBS), and are converted to HMTL by WinIBW3.  

5.1.1 Copying Data 

There are two ways to copy data from a Full Presentation screen, either by selecting text using the mouse, or 

with the Copy title function from the Edit menu. 

Text is copied with the mouse by clicking in the presentation screen, and dragging the mouse with while 

holding the left button pressed down to another location. Ctrl-C is pressed (or the Copy function from the 

Edit menu) to copy the data to the clipboard, to be used in other places in WinIBW3 or in other applications.  

The menu-based Copy title function copies the complete record, with one important difference between 

copying using the mouse: expansions are not included. 

5.1.2 Navigating In and Between Screens 

When the length of a presentation screen is longer than the size of the Document Window, a vertical 

scrollbar is automatically displayed. The user can scroll up and down using this scroll bar, but can also use the 

PgUp and PgDn keys or the mouse scroll wheel. The Up-Arrow and Down-Arrow keys can also be used, but 

that may require clicking in the text area of the Document Window first, since the Command Line also 

responds to the arrow keys. 

Certain presentation screens, such as the Full Presentations of bibliographic records from a set, allow for 

paging forward and backward using the Enter, Alt-Arrow-Left and Alt-Arrow-Right keys. There are also two 

buttons available in the toolbar with the same function. 

5.1.3 Font Settings and Syntax Coloring 

Font settings can be adjusted via the User Preferences dialog tab Fonts and Colors. Note that the 

appearance of parts of certain screens may be defined within the screen definition itself, so that the user 

preference settings here may be overridden. 

WinIBW3 now also supports syntax coloring in presentations. Syntax coloring is format specific, and can be 

defined when the site-specific setup of WinIBW3 is created. The definition is stored in 

scripts/config_<site>.js. but is not intended to be modified by the user. 

5.1.4 Links 

When bibliographic data contains links to other bibliographic data, clicking on these links instructs WinIBW3 

to retrieve and display this data. Clicking on a link with the right mouse button brings up a context menu that 

allows for opening the link in a new window. 
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A presentation may also contain HTML links. Clicking on such a link will cause the targeted page to be 

opened by the given machine's standard web browser. 

5.1.5 Printing 

There are usually two options for printing presentation screens: via a command corresponding to the type of 

data being shown, or with the Print function from the menu or toolbar. When the Print function is used, 

the default print settings are applied. When the print command is used, the settings for the specific print type 

are applied. See section 7 for more details. 

5.2 Short Presentation 

Short presentation screens contain a list control. Examples are the short presentation screen showing a 

result set of bibliographic data after a search command, and the Scan screen. Also the history screen contains 

a list control, as well as certain ILL screens. 

It is possible to resize the columns of the list control by dragging the separator between the column headers. 

These changes are stored in the user profile and thus persist between sessions. When columns are too 

narrow to display all of the data, this is indicated by an ellipsis at the end of the data. In WinIBW3 all columns 

are distributed over the width of the Document Window; horizontal scroll bars no longer appear. 

Moving up and down through the list is possible using standard keys Up- and Down-Arrow to move the 

cursor up or down one line, PgUp and PgDn to move the cursor one page up or down, and Home and End to 

move the cursor to the first or last element in the list (except in the Scan screen, because there is no last or 

first element in this list). Also the vertical scroll bar can be used to traverse the list, and the scroll wheel of 

the mouse (if present). When using the vertical scroll bar and the scroll wheel of the mouse, the selected 

item is not changed. 

An item in the list is selected by double clicking on it, or by pressing Enter when it is highlighted. The follow-

up action is defined in the screen definition of the remote system, and depends on the type of list: in a Scan 

screen the follow-up action will be a short or full display of the selected set, in a short presentation screen it 

will be the Full Presentation of the selected record, etc. When the user subsequently presses Escape, in 

general the previous screen containing the list will be shown again, with the previously selected item 

highlighted. 

The screens containing list controls can usually only be printed with the appropriate command; the Print 

function in the menu or toolbar is disabled. 

Note: There is a use case executed by the following steps:  

1. open a new window from a short title presentation, 

2. open an edit window via command ‘\inv’, 

3. change back to the first window by Pressing ‘Ctrl+F6’, 

4. type a command 

It is expected that the typed texts will be on the command line and the ‘copy PPN’ function is enabled in the 

short title presentation. However, the typed texts are in the editor somehow and the ‘copy PPN’ function is 

disabled in the short title presentation. If this is the case, please use the following ways to execute this use 

case, which has the expected results: 
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• After change back to the first window by Pressing ‘Ctrl+F6’, please activate command line before 

type a command. In this way, focus is on the command line when you are typing so that the typed 

texts will on the command line instead in the title editor.  

• After change back to the first window by Pressing ‘Ctrl+F6’, please select any one title from the 

short presentation. Then the ‘copy PPN’ function will be enabled in the short title presentation. 

5.3 Deduplication Screen 

In the deduplication screen two bibliographic records are presented side by side, so that the use can compare 

the two records to decide whether the records are equal or not. The record at the left side is the record 

retrieved with some search command, the record on the right side is the record that is pointed at from one 

of the tags in the first record (normally Pica+ tag 038L). 

When the record pointed at from the first record cannot be found, a message indicating this is displayed 

instead of the record itself. 

The space in the window is automatically divided by WinIBW3 so that both records have approximately the 

same width. Since WinIBW3 tries to determine the best position to wrap tags that are too long to the next 

line, this division is not always exactly 50% for each record. It is no longer possible that the user adapts the 

width of both records, as in WinIBW2. 

To emphasize the similarities and differences between the two records, they are presented in two different 

colors. Where WinIBW2 could only distinguish between different or equal complete tags, WinIBW3 refines 

this so that different and similar parts of tags are shown. The default colors used for differences and 

similarities can be specified in the file \defaults\pref\ibw_prefs.js, in the preferences 

"winibw.deduplication.equalColor" (default value "#009000") and 

"winibw.deduplication.differentColor" (default value "#c00000"). The colors used for 

differences and similarities can be respectively set in the field Equal texts and Different texts of the color box 

for the Deduplication screen of the screen object via menu Options\Fonts and Colors. 

The following is the explanation of how the duplication algorithm works: 

Title 1 Title 2 

0100 999 

3000 James Joyce 

0100 888 

3000 James Smith 

999, and Joyce is in red because they are not 
present in Title 2. 

888, Smith is in red because they are not 
present in Title 1. 

 

Deduplication screen marks the first letter of word sequences that do not match in continuous 
blocks: 

Title 1 Title 2 

3000 James Joyce 

3001 Markus Gary Boyle 

3000 Smith Boyle 

3001 Joyce Markus Gary 

James is in red because it is not in Title 2. 

 

Consider the case: 3001 Joyce Markus Gary 

If we did not mark first letters with red the 
whole 3001 tag would be green which gives a 
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3001, only first letter is red. It is present in both 
titles, however the word “Joyce” that comes 
before “3001” is not “Boyle” which comes 
before “3001” in Title 2, i.e. Title 1:“Joyce 3001” 
do not match to Title 2:“Boyle 3001”. 

 

Markus, first letter is red. It is present in both 
titles, however Title 1: “3001 Markus” is not 
present in Title 2. 

 

Boyle, first letter is red, because “Gary Boyle” is 
not in Title 2, or “Gary Boyle” does not match 
in continuous blocks. 

wrong impression that the whole tag is same as 
in Title 1. 

 

 

The other font settings are the same as those set for the Full Presentations. 

By using buttons in the button bar of the deduplication screen, the user can decide if the two records 

presented are equal or not equal, or that it is not known. The CBS will subsequently annotate this in the left 

record (also in Pica+ tag 038L). When the record is part of a set with more than one record, after pressing 

one of the buttons WinIBW3 displays the next record in the set together with its possible duplicate. 

All screen manipulation is identical to that of the normal Full Presentation screen, except that it is possible to 

select and copy one or both of the presented records. The deduplication screen can be printed using the 

print function in the File menu or the print button on the toolbar. 
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6 Cataloging 

The process of creating, updating and deleting bibliographic and authority records is called cataloging. This 

process is started with the command \MUT (or the language or site-specific equivalent) or by pressing the 

Edit button on a short or Full Presentation screen. This section does not describe the cataloging rules how to 

catalogue a bibliographic record or the cataloging format being used, but only describes the tool that is used. 

The basic facility available for cataloging is the edit screen, containing an almost full screen editor. Editing is 

on a per-record basis (rather than on a per-line basis), which means that an entire record is retrieved from 

the remote system to be edited, and the complete record is sent back for validation and further processing. 

This method of cataloging using the full screen editor (Title Edit Control) is sometimes referred to as expert 

mode cataloging. 

An alternative for the expert mode screen is Coded Data / Novice Mode. This works in conjunction with the 

remote system, where Coded Data and Novice Mode screens, template and lists must be properly set up. 

Some special functions available during cataloging are discussed in more detail in section 9: the Automatic 

Linking function, the Title Copy function and the Table function. 

6.1 Title Edit Control 

The WinIBW3 editor is a multi-line edit control with some special features for the cataloging process. 

6.1.1 Standard Editing Functions 

The editor offers a full set of navigations and editing functions. The following sections give an overview, with 

the (shortcut) keys that can be used, and the menu functions. Note that the shortcut keys can be configured 

differently when a site-specific setup of WinIBW3 is created, and can be different. 

A context menu is available in the editor that pops up when the right mouse button is clicked. This menu 

contains the same functions as the Edit menu. 

6.1.1.1 Cut, Copy and Paste Text 

 

Task Shortcut Menu Item 
Cut text from editor Ctrl-X Edit -> Cut 
Copy text to clipboard Ctrl-C  Edit -> Copy 
Paste text from clipboard Ctrl-V Edit -> Paste 
Copy PPN to clipboard  Edit -> Copy PPN 
Undo Ctrl-Z Edit -> Undo 
Redo Ctrl-Y Edit -> Redo 
 
The function Copy PPN to clipboard can also be used in the full and short presentation of bibliographical 
records. 
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6.1.1.2 Navigation Keys 

 

Motion Keys 
Character left, right Left, Right 
Line up, down Up, Down 
Word left, right Ctrl-Left, Ctrl-Right 
Begin, end of line Home, End 
Page up, down PgUp, PgDn; Ctrl-Up, Ctrl-Down 
Begin, end of text Ctrl-PgUp, Ctrl-PgDn 
Go to line Ctrl-G, Edit -> Goto Line... 

6.1.1.3 Editing 

 

Action Keys 
Insert new line Enter 
Remove character in front of the cursor Backspace 
Remove character behind the cursor Delete 
Toggle Insert / Overwrite mode Insert 
Submit data to remote system Enter from the numeric keypad 

6.1.1.4 Find and Replace 

 

Action Keyboard Menu 
Find Ctrl-F Edit -> Find 
Find Next F3  repeat last Find 
Find & Replace Ctrl-E Edit -> Find / Replace 

 

         

 

The search action can be restricted to match the case of the word, match only complete words, or search 

only on the current line. A search action always starts from the current line, going "downwards" in the text. 
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6.1.1.5 Select Text 

Text can be selected (highlighted) by dragging the mouse over the text, with the left button pressed down, or 

using the navigation keys (the arrow keys, PgUp, PgDn, Home, End) together with the Ctrl-key. In addition, 

the Find action will highlight any text that it finds. 

6.1.1.6 Discard made changes 

If a user has made one or more changes in the title editor and presses the ‘F5’ key, the dialog ‘Do you want 

to discard the changes you made?’ will be shown. When the use presses the ‘Yes’ button on this dialog, all 

changes made in the title editor will be rolled back. When the ‘No’ button is pressed, the user will stay in the 

title editor with the changes made so far. 

If a user has made any change in the title editor and presses the ‘Esc’ key, the dialog ‘Do you want to discard 

the changes you made?’ will be shown. When the user presses the ‘Yes’ button on this dialog, all changes 

made will be discarded and the editor will be closed. When the ‘No’ button is pressed, the user will stay in 

the title editor with the changes made so far.  

6.1.2 Expansions and Protection  

An expansion is text inserted into the data presented in the editor that was retrieved from a linked record. 

This text is not meant to be changed, so this is simply prohibited in the editor. Such protected text can be 

recognized because it is displayed in another color (usually green), and is possibly in italics. 

When data containing an expansion is copied to the clipboard, the expansion is not included. 

Text is protected when the user is not authorized to edit some or all parts of a bibliographic record. The 

protection can be per tag, and is determined by the remote system. Protection is indicated with invisible 

markers in the text. Protected text is displayed in another color (usually red) and cannot be changed by the 

user. It is however possible to insert new lines between two protected tags. Protected text can be copied to 

the clipboard, but the markers are not copied. It is therefore possible to copy protected text as unprotected 

into the record being edited. This is in usually not allowed, but validation is left to the cataloging server of the 

remote system. 

6.1.3 Error Messages 

When the user is finished creating or editing a record, the changes are submitted to the cataloging server of 

the remote system. This server performs several validations, and if everything is correct, the record is 

inserted or updated in the database. An ‘OK’ message is returned to WinIBW3, and the record is presented 

in the Full Presentation, closing the editor. 

When a validation error occurs, it is reported in two forms: 

• a short form consisting of the tag where the error occurred, and a code indicating the type of error 

(for example “0600 I” = unknown tag code 0600, “0500 R” = Tag 0500 is not repeatable, “4000 O” = 

Tag 4000 is missing, etc.). 

• a more verbose form of the same error message, that is displayed in a dialog box when the user 

presses the button Error Info. 

6.1.4 Context Sensitive Help 

WinIBW3 is capable of presenting context sensitive help screens in the standard browser by constructing 

URLs that contain the tag code of the line where the cursor is located. The exact structure of these URLs is 
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determined when the site-specific setup of WinIBW3 is created, and help pages must be provided at these 

URLs. WinIBW3 can also distinguish between tags of bibliographic records and authority records, and 

construct different URLs. When WinIBW3 cannot determine the tag code (or when the edit screen is not 

activated), a URL referring to an index page is generated.  

6.1.5 Syntax Coloring 

WinIBW3 can display parts of the cataloging format such as subfield indicators in a separate color.  

Syntax coloring for cataloging is defined when the site-specific setup of WinIBW3 is created, and stored in 

scripts/config_<site>.js. It is not intended to be modified by the user. 

6.1.6 Multiple Cataloguing Formats Configuration 

WinIBW3 can be configured to support more than one cataloguing formats at the same time. See SetupStudio 

3.0 for more info about how to configure WinIBW3 for multiple cataloguing formats.   

6.1.7 Unicode display  

The properties of the character locating directly after the cursor will be displayed below at the left corner on 

the status bar in the format: 

(Ln: xx Col: yy) Char: C, Unicode: U+zz 

Here, xx and yy are the line and column of the displayed character, respectively. C is the displayed character 

and zz is the Unicode value of the displayed character. 

Note: Displaying the properties of a specific character can be invoked in 2 ways: 

• Pressing the left or right arrow keys; 

• Moving cursor to the wanted position and 2 times clicking the left mouse (but not double clicking the 

left mouse). 

6.1.8 Right To Left writing (RTL)  

WinIBW3 provides the RTL (Right To Left writing) functionality in the title editor. 

In the title editor, the RTL function can be switched between ‘enabled’ and ‘disabled’ by the following 2 ways: 

• Pressing the short-cut ‘Ctrl+Alt+L’.  

• Checking or un-checking the sub-menu ‘RTL’ under main menu ‘Edit’. 

When the RTL function is disabled, the sub-menu ‘RTL’ under main menu ‘Edit’ is enabled but unchecked and 

nothing is shown at the RTL indicator (the 5th item at the bottom right corner of the WinIBW3 window).  
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When the RTL function is enabled, the sub-menu ‘RTL’ under main menu ‘Edit’ is checked and ‘RTL’ is shown 

at the RTL indicator.   

 

When the RTL function is enabled, WinIBW3 will do the followings by typing a tag followed by typing a ‘.’: 

• make the current line into the RTL state, where the tag is marked with the RTL color (the default 

RTL color is ‘blue’. However, it is configurable with another color.)  

• put the cursor at the end of line for RTL, which can be seen at the status bar.  
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From now on, a letter of a RTL language can be inserted by just typing it. E.g. a number of Hebrew letters are 

inserted at the tag 3001. The arrow keys ‘←’, ‘→’, ‘↑’ and ‘↓’ and mouse can be used to bring the cursor to 

the wanted position. When moving one of the arrow keys, the cursor position will be displayed at the status 

bar.  

 

When something is wrong with the RTL line, the whole line will be marked with the RTL error color as 

follows (the default RTL error color is ‘orange’. However, it is configurable with another color). In this case, 

the RTL line needs to be deleted.  
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See the section “RTL configuration for WinIBW3 title editor” of the document “SetupStudio 3.0 – User 

Manual.doc” about how to specify both the RTL color and RTL error color in the WinIBW3 title editor. 

The state that the RTL function is enabled or disabled will be saved when WinIBW3 is closed. Next time 

when the user is for the first time in the title editor after WinIBW3 start-up, the RTL function will be 

automatically enabled if the RTL function is enabled before the last WinIBW3 close-up. For the multiply title 

editors, the state of each editor is saved individually so that the editors can work independently from each 

other for RTL. In that case, the state of the last active editor before the last WinIBW3 close-up will be saved 

when WinIBW3 is closed. 
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6.1.9 Spell check and Auto-complete 

WinIBW3 provides spell check and auto-complete functionality in the title editor.  

As soon as a user is for the first time in the title editor after WinIBW3 start-up, all the specified dictionaries 

(here, a language-dependent dictionary means a language-dependent word list used for both spell check and 

auto-complete) will be loaded into WinIBW3 one by one. In WinIBW3 version 3.6, the following 6 WinIBW3-

system dictionaries are available for spell check and auto-complete functionality, each coded in UTF-8 format 

for one language and stored in one ‘.txt’ file: 

• Winibw_autocomp_du.txt (Dutch) 

• Winibw_autocomp_en.txt   (English) 

• Winibw_autocomp_fr.txt    (French) 

• Winibw_autocomp_ge.txt (German) 

• Winibw_autocomp_it.txt (Italian) 

• Winibw_autocomp_sp.txt (Spanish) 

All dictionaries are located in the “\wordlists” directory under the WinIBW3 installation. When making a 

WinIBW3 setup, the file name of a dictionary to be used and its location have to be specified. See the section 

“Spell check and auto-complete configuration for WinIBW3 title editor” of the document “SetupStudio 3.0 – 

User Manual.doc” about how to specify the dictionaries for the spell check and auto-complete features for 

the WinIBW3 title editor.   

In the first run of WinIBW3 after its installation, the directory 'wordlists' under user profile will be deleted. 

Then, either the directory 'wordlist' under user profile will be created again in case that 

pref("winibw.features.editscreen.spellcheck", true); is set or  the directory 'wordlist' under user profile will 

not be created in case that pref("winibw.features.editscreen.spellcheck", false); is set. 

The dictionary loading takes place only once. During the loading, the followings can be observed: 

• A progress message is shown in the WinIBW3 status bar.  
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• The following sub-menus under main menu ‘Edit’ are disabled: 

- Spell Check 

- Add Word 

- Specify tags for spell check 

- Change dictionary for spell check and auto-complete 

• The status ‘Please wait, loading …’ under item ‘Spell check’ is shown when right clicking on the 

mouse. 

• Nothing is shown at the indicator for spell check (the last item at the bottom right corner of the 

WinIBW3 window). 
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When all the specified dictionaries are loaded into WinIBW3, the message 

“Dictionaries are loaded. Spell check and auto-complete functions are now available. Please, enable them before use if 

disabled.”  

will be displayed in the status bar.  Besides, the sub-menu ‘Spell Check’ under main menu ‘Edit’ is enabled and 

the sub-item “Enable” or “Disabled” (depending on the last state before WinIBW3 down, but always “Enable” 

for the first time after WinIBW3 installation) under item ‘Spell check’ is displayed when right clicking on the 

mouse. 
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From now on, the spell check and auto-complete features can be used in the title editor.  

6.1.9.1 Spell check 

By default, the spell check function is disabled. When the dictionaries have been loaded (see section “Spell check 

and auto-complete” about loading dictionaries) , the spell check function can be switched between ‘enabled’ and 

‘disabled’ by using one of the following methods: 

• Pressing the short-cut ‘Ctrl+Alt+K’. 

• Checking or un-checking the sub-menu ‘Spell Check’ under main menu ‘Edit’. 

• Clicking ‘Enable’ or ‘Disable’ under item ‘Spell check’ when right clicking on the mouse. 

When the spell check function is enabled, the following can be observed: 

• The indicator for spell check displays ‘SPCK’ at the bottom right corner of the WinIBW3 window. 

• The sub-menu ‘Spell Check’ under main menu ‘Edit’ is checked and the following sub-menus are 

enabled.  

- Add Word 

- Specify tags for spell check 

- Change dictionary for spell check and auto-complete 

• Both ‘Disable’ and ‘Add word’ under item ‘Spell check’ when right clicking on the mouse are 

displayed.  
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At this time, the loaded dictionary with the same language as the one of the working title is being used for 

spell check. As a result of the checking, all the words at the specified tags, which are not in the dictionary, 

will be marked with a specified color. The default marking color for spell check is ‘fuchsia’. However, it is 

configurable with another color. When no dictionary having the same language as the one of the working title 

is available, the default dictionary for spell check will be used. See the section “Spell check and auto-complete 

configuration for WinIBW3 title editor” of the document “SetupStudio 3.0 – User Manual.doc” about how to 

specify the tags for spell check and the marking color at WinIBW3 setup.  

See the example below. The language of the working title is English, see the content of tag ‘1500’. Therefore 

the loaded English dictionary is being used. Tags: 4000, 4030, 4201 and 5500 are specified for spell check and 

the default color (fuchsia) is specified for the marking color. So, all the words at those tags, which are not in 

the English dictionary, are marked with fuchsia.  

 

 

As mentioned above, tags for spell check are specified during WinIBW3 setup. However, tags for spell check 

can be re-specified within WinIBW3 whenever a user wants to. When spell check function is available, tags 

for spell check can be changed in two ways: 

• Pressing the short-cut ‘Ctrl+Alt+T’. 

• Pressing the sub-menu ‘Specify tags for spell check and auto-complete’ under main menu ‘Edit’. 

After invoking one of them, the dialog ‘Edit tags for spell check’ will be shown with an overview of current 

tags for spell check in the list ‘Tags overview for spell check’.  
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On this dialog, a selected tag in the list ‘Tags overview for spell check’ can be moved up or down by pressing 

the button ‘Move up’ or ‘Move down’, respectively. The tags shown in the list ‘Tags overview for spell check’ 

can be sorted by pressing the button ‘Sort’. Tags can be edited as follows: 

• Insert one new tag: 

Type one tag in the field ‘Tag to be added’ and press the button ‘Insert tag’, the wanted tag will be 

added into the list ‘Tags overview for spell check’. 

• Update one existing tag: 

Select a tag from the list ‘Tags overview for spell check’, type a wanted tag in the field ‘Tag to be 

added’ and press the button ‘Update tag’, the selected tag will be replaced with the wanted one. 

• Delete one existing tag: 

Select a tag from the list ‘Tags overview for spell check’ and press the button ‘Delete tag’, the 

selected tag will be deleted from the list ‘Tags overview for spell check’. 

Note: A regular expression for tags on which spell check takes place is applicable. E.g. 20(0|3)0, 

40(0|3|6)0, 41(0|8)0, 5500, 420. and 480(1|2) are all valid values for a tag.  

After pressing the button ‘OK’, all the updates for the list ‘Tags overview for spell check’ will be saved in the 

file “user_prefs” under the user profile, where the tag’s are separated by semi-comma, so that they can 

be reused next time when WinIBW3 start-up. Besides, spell check will immediately take place on all the tags 

in the new list.  
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As mentioned above, the language of the dictionary for spell check for a working title is always the same as 

the one of a working title. If this dictionary is not available, the default dictionary for spell check (specified at 

WinIBW3 setup) will be used. However, the dictionary for spell check can be re-specified within WinIBW3 at 

any time when a user likes. When spell check function is available, the dictionary for spell check can be 

changed by the following 2 ways: 

• Pressing the short-cut ‘Ctrl+Alt+C’. 

• Pressing the sub-menu ‘Change dictionary for spell check and auto-complete’ under main menu ‘Edit’. 

After invoking one of them, the dialog ‘Dictionary for spell check and auto-complete’ will be shown. 

 

On this dialog, the language of the current dictionary and an overview of languages of all available dictionaries 

are displayed in the field ‘Current dictionary’ and in the list ‘Available dictionaries’, respectively. After 

selecting one language from the list ‘Available dictionaries’ and pressing the button ‘OK’, the dictionary 

corresponding to the selected language will immediately be used, which can also be seen in the status bar at 

the bottom of the WinIBW3 window. The new specified dictionary for spell check will not be saved for later 

use. It is just used timely for the current title. 
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When ‘SPCK’ is shown at the spell check indicator, the word at the cursor position can be added into the 

dictionary by one of the following ways: 

• Pressing the short-cut ‘Ctrl+Alt+A’. 

• Pressing the sub-menu ‘Add Word’ under main menu ‘Edit’. 

• Clicking ‘Add word’ under item ‘Spell check’ when right clicking on the mouse. 

Then, the following dialog will be shown: 

 

After pressing the button ‘OK’, the target word will be added into a user dictionary (locating in the 

“\wordlists” directory under the user profile location) with the same language as the one of the working title 

but with another file name (e.g. winibw_autocomp_en_custom.txt is the file name for the user’s English 

dictionary). If the word is already in the dictionary (either a WinIBW3 system dictionary or a user dictionary), 

the message ‘the word is already in dictionary’ will be shown at the status bar. See example below. The 
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cursor is at the word ‘relations’ at the tag ‘4000’. When the ‘Add word’ is triggered by one of the methods 

mentioned above, the message ‘the word is already in dictionary’ is shown at the status bar. 

 

 

 

In case the spell check function is disabled, the indicator for spell check shows nothing, the sub-menu ‘Spell 

Check’ under main menu ‘Edit’ remains enabled but unchecked and only ‘Enable’ under item ‘Spell check’ 

when right clicking on the mouse is displayed. 

The state that the spell check function is enabled or disabled will be saved when WinIBW3 is closed. Next 

time when the user is for the first time in the title editor after WinIBW3 start-up, the spell check function 

will be automatically enabled right after the dictionary loading is ready if the spell check function is enabled 

before last WinIBW3 close-up. For the multiply title editors, the state of each editor is saved individually so 

that the editors can work independently from each other for spell check. In that case, the state of the last 

active editor before WinIBW3 close-up will be saved when WinIBW3 is closed. 
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6.1.9.2 Auto-complete 

As soon as loading dictionaries (see section “Spell check and auto-complete” about loading dictionaries) is ready, 

the auto-complete feature is available in the title editor.  

When a user types the first letter(s) of a word and presses the Ctrl+Shift+Space key, a pop-up will be 

displayed, at the current cursor position, showing a list of partially matching words, and the first word in that 

list will be selected. For each call of the auto-complete, the pop-up will be filled with at most 5000 words, 

including all the words partially matching the searched letter(s). For example, if the searched letter is ‘a’, only 

up to 5000 words from the first word with the initial letter ‘a’ in the dictionary are filled in the list and 

displayed in the pop-up. When the user double-clicks on a word on that list, the letter(s) in the title editor 
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will be replaced by the selected word and the pop-up will disappear. The following screen shows a pop-up 

with a list of words matching the letters ‘supp’ in the title editor. 

 

 

 

There are a number of special cases concerning auto-complete functionality: 

• In case no words in the being used dictionary match the searched letter(s), nothing happens; 

• In case the searched letters exactly and uniquely match a word in the dictionary, nothing happens; 

• In case the searched letters uniquely match a word in the dictionary, they are replaced by the matched 

word and the pop-up disappears; 

• In case there is not enough space to display the pop-up (for example, the cursor is at the bottom of the 

title editor),  nothing happens; 

 

The dictionary for auto-complete can also be timely changed for the current title in the same way as the one for 

changing dictionary for spell check. 

6.2 Coded Data and Novice Mode 

WinIBW3 provides Coded Data (CD) functionality that simplifies cataloging in formats that use fixed 

positions and encoded information. WinIBW3 can display each fixed position element of a bibliographical 

record in a separate control with an appropriate label to identify the element. For encoded information, 

WinIBW3 can provide a list of available values without the user having to remember the corresponding 

codes. 

Novice Mode (NM) functionality was introduced to simplify cataloging for novice users. Instead of being 

presented with a ‘raw’ title editor to the user, displaying tags, indicators and sub-fields, the user can simply fill 

in controls which labels attached to them providing information about the information stored in the controls. 
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The handling of CD and NM is done completely within WinIBW3, i.e. the cataloging server sees no difference 

between data received from WinIBW3 with CD and/or NM handling enabled or not.  

CD and NM handling is done in WinIBW3 at a level of abstraction above the bibliographical format.  

WinIBW3 uses generic ‘field identifier’ in CD and NM templates, making them, in principle, independent of 

the cataloging format. 

To achieve this, WinIBW3 uses a configuration file for each supported format that specifies how a field can be 

identified in a certain bibliographical format. This can be a tag-subfield-(indicator-) combination, a certain 

position in a tag or a certain punctuation sequence. 

Apart from this, the format configuration also allows the assignment of default values to a field, specifying a 

list of valid values and assigning a ‘display type’ to a field. 

All configurations for CD and NM are stored in HTML or XML on the remote system (or optionally on the 

local file system). The administrator must never deal with XML himself but will only fill in HTML tables or edit 

HTML templates. The Pica template editor will check the configuration's syntax and partially semantics, 

compile it into XML and optionally deploy it to the cataloging server. 

WinIBW3 will cache the files locally and uses a version checking mechanism to only retrieve updated or not 

yet retrieved files from the server. 

Coded Data and Novice Mode are described in much more technical detail in the WinIBW System 

Administrators Guide. 
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7 Printing and Downloading 

There are two different methods available for printing: 

• via the WinIBW3 print function, used for printing the content of the current screen 

• via the CBS print commands 

7.1 WinIBW3 Print Function 

The WinIBW3 print function basically prints the content of the current window, and can be used to easily 

make a hardcopy of a bibliographic record presented on the screen. 

The print functions can be invoked via either the File menu, the button on the toolbar or the associated 

shortcut key, assuming that this has been properly configured in the user interface of the WinIBW3 setup.  

Certain screens do not allow for printing via this method. This concerns screens containing special controls, 

such as list controls on the short presentation, scan and history screens, or the title edit control on the edit 

screen. In these cases, the WinIBW3 print function is disabled and the user must resort to a corresponding 

print command. 

The destination of the print function is no longer set in the user preferences dialog, but via the Print Setup 

dialog box for the default print settings that is invoked from the File menu.  

7.2 Print Commands 

When the user issues a print command, the CBS now also returns the so-called “printing type” which is an 

identifier for the type of data being printed. This printing type is subsequently used by WinIBW3 to allow for 

different print format settings for each printing type. When a printing type is encountered for the first time, 

WinIBW3 assumes the default print settings, but allows for changes to these settings which are then stored 

under this identifier. Before printing a type for the first time, WinIBW3 presents the print setup dialog. Also a 

menu entry in the Print Settings submenu is added, so that these settings can be modified later. The menu 

entries are defined via a CBS parameterization (see below). 

This mechanism allows the user to configure the printer settings differently for each of the print commands, 

so that, for example, the short presentation is printed in landscape format, while the full presentation is 

printed in portrait. 

At the moment, WinIBW3 supports the following printing types: 

CBS command Printing type Description 
\PRI <illnum> \BON ill-slip-normal Normal ILL slip (including test slips) 
\PRI <illnum> \RAP ill-slip-reminder Slip for ILL reminders 
\PRI <illnum> \COM ill-slip-compact Compact ILL slip 
\PRI <illnum> \VRY ill-slip-free FCV driven ILL slip 
\PRI <illnum> [\LAN] ill-presentation-full Full ILL request (edifact, U, etc.) 
\PRI <illnum> \KOR ill-presentation-brief Brief ILL request 
\PRI <ttlref> [\LAN] title-full Full title 
\PRI <ttlref> \KOR title-brief Brief title 
\PRI \STA \USE <usridt> statistics-user User statistics 
\PRI \STA \BIB <libidt> statistics-library Library statistics 
\PRI \USE <usridt> user-slip User slip (login / password info) 

where <ttlref> = [[<set>] <number>]. 
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The possible printing types are specified as parameters  in a CBS application control table (ACTABL)  record, 

defined as follows: 

ACTABL#PRINTTYPES#<language> 

The printing type is used as attribute, the contents of each attribute is the description.  

Example:  

[ACTABL#PRINTTYPES#EN] 

\ill-slip-normal=Normal ILL slip 

\ill-slip-reminder=Slip for ILL reminders 

\ill-slip-compact=Compact ILL slip 

\ill-slip-free=Free format ILL slip 

\ill-presentation-full=Full ILL request 

\ill-presentation-brief=Brief ILL request 

\title-full=Full title 

\title-brief=Brief title 

\statistics-user=User statistics 

\statistics-library=Library statistics 

\user-slip=User slip 

\\ 

Note that when something is printed not via a command, but using the menu or the toolbar, the default 

printing settings are used. 

7.3 Print Setup 

The File menu contains a Print Setup submenu, which initially contains one entry, Default print settings.  

 

Before the print command \PRI is used for other types of printing, the default print settings need to be set, which 

can be done by pressing OK button on the page setup dialog in the entry Default print settings, because the 

default settings need to be known at WinIBW3.  

 

After the print command \PRI is used for other types of printing, new entries are added to this menu, starting 

as a copy of the current default settings, but optionally adjusted for the specific type. Note that the default 

settings are always used for printing with the Print function in the menu or toolbar. 
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7.3.1 General Print Settings 

The following dialog is presented when the print settings are changed: 

 

 

 

The user can select one of the available printers supplied by Windows. The Print Range can be set to All 

Pages, a specific range of pages, or the current selection. The number of copies can be specified, and the 

number of records per page. When the page displayed contains frames, it is possible to specify how the 

frames are to be printed. 

The dialog for other properties is shown when Properties... button is pressed. 



 

project:  

document name: WinIBW3 Product Description 

version: 2.7 

 

  

Date 18-11-2013 page 66 of 126 

 

7.3.2 Format & Options 

 

 

 

On the Format & Options dialog the user can specify the orientation of the page to be printed, and optionally 

a scaling factor. The scaling factor cannot be set when the user specifies to fit the data to the page width, thus 

ensuring that everything fits on the page. 
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7.3.3 Margins & Header / Footer 

 

 

 

The user can specify the top, right, bottom and left margins separately on the Margins & Header / Footer 

dialog, and the text to be printed as header and footer of the page. Both the header and the footer consist of 

three parts: left aligned text, center aligned text and right aligned text. For each of the parts the user can 

select one of 

• Title 

• URL 

• Date / Time 

• Page number (of total number of pages) 

• Custom text, such as the user’s name 

7.4 Downloading 

There are two methods for downloading, which differ only slightly in functionality: 

• The download command (\DOW) 



 

project:  

document name: WinIBW3 Product Description 

version: 2.7 

 

  

Date 18-11-2013 page 68 of 126 

 

• The download menu function. 

The only difference is that the download menu function asks the user what the destination of the downloaded 

data is, while the download command assumes the value set in the user preferences record. 
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8  Scripting 

8.1 Introduction 

WinIBW3 makes a distinction between two types of scripts: 

• User scripts: the scripts are created by the end users of WinIBW3. 

• Standard scripts: the scripts are provided by OCLC or site administrators, and included in the 

WinIBW3 setup. 

Two scripting languages are supported for the user scripts: JavaScript (js) and Visual Basic Script (VBScript, 

vbs). However, only JavaScript can be used for the standard scripts. 

For scripting in WinIBW3, the supported object model is very similar for Visual Basic Script and JavaScript. 

Please refer to the documentation “Scripting in WinIBW3” for details about the available functionality. 

Since user scripts and standard scripts are processed and executed in two different environments, there are 

some differences between the scripting in user scripts and the scripting in standard scripts. See the 

documentation “Scripting in WinIBW3” about the differences. 

Note: From WinIBW version 3.7 on, the maximum number of standard script functions which can be loaded 

into WinIBW3 is 999 and the maximum number of user-defined script functions which can be loaded into 

WinIBW3 is 999.  

8.2 User Scripts 

8.2.1 Script Editor 

In WinIBW3 there is a Scripting IDE embedded, which is used to define new user script functions and to edit 

existing ones. This IDE can be invoked by the menu command ‘Script | Edit script’, see section Appendix A 

about the functionality of the IDE and how to use it. 

8.2.2 Scripting Language 

Which scripting language (JavaScript or VBScript) to be used for user scripts is defined during creation of the 

WinIBW3 setup (see the documentation “SETUPSTUDIO 3.0 User Manual” for more about it) and stored in 

the file ‘setup.js’ as a preference: 

pref("ibw.userscript.language", "js");   

or  

pref("ibw.userscript.language", "vsb"); 

However, the scripting language can also be random switched within WinIBW3. Via the menu command 

‘Script | Edit Script’, the script editor for user scripts will be opened. At the script editor, the scripting 

language can be selected via the menu ‘Language | JavaScript’ or ‘Language | VBScript’. The selected scripting 

language will be saved in the preference "ibw.userscript.language" at the closure of the editor so that the last 

selected scripting language shall be used when the editor is opened again.   

If no scripting language is selected, i.e. the menu ‘language | From file extension’ is selected, which scripting 

language (JavaScript or VBScript) will be used as the scripting language, based on the extension (js or vbs) of 

the current user script file that is described in section 8.2.3. 
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8.2.3 User Script File 

The file in which all the user defined script functions and concerned scripting statements are stored is the 

user script file. The current user script file is the script file that is being used in WinIBW3 and its contents 

are locating at the WinIBW3 user script editor.  

The last used user script file before the editor is closed will be saved in the preference 

"ibw.userscript.language" at the closure of the editor so that it shall be used when the editor is opened again.  

8.2.3.1 Default User Script File 

For each scripting language (JavaScript, VBScript), there is a default file in the current user’s Profile directory 

for saving user scripts: 

• The file ‘winibw.js’ for JavaScript  

• The file ‘winibw.vbs’ for VBScript  

After the menu ‘File | Open default’ is selected at the script editor which can be opened via the menu 

command ‘Script | Edit Script’, one of the default script files will be used or the contents in one of the default 

script files will be loaded into the editor, depending on the selected scripting language described in section 

8.2.2. All the script statements in the editor can be saved in the selected default script file via the menu ‘File | 

Save’, or in a user specified script file described in the next sub-section via the menu ‘File | Save as’. 

8.2.3.2 User Specified Script File 

Beside the default user script files described in the previous sub-section, users are allowed to specify their 

own script files, which make it possible that users group their script functions and store each of the groups 

wherever they like.  

A user specified script file can be created via the menu File | New at the script editor and saved in a file 

specified by users via the menu ‘File | Save as’. The file can be saved only with the extension either ‘js’ or 

‘vbs’, depending on the selected scripting language. If the extension is not provided, an extension (js or vbs) 

consistent with the selected scripting language will be automatically appended to the file name. In case the 

menu ‘language | From file extension’ is selected, it is user’s choice which extension to use for the script file. 

An existing user script file can be loaded into the script editor via the menu File | Load. When the menu 

Language | JavaScript or the menu Language | VBScript is selected, the file only with the extension (js) or (vbs) 

can be loaded. In case that the menu ‘language | From file extension’ is selected, it is user’s choice which file 

to load. The loaded file is taken as a JavaScript or VBScript file, according to its extension.   

8.2.4 Scripting 

8.2.4.1 Adding a New Script Function 

A new script function can be added via the menu command ‘Script | Add a script Function’.  
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After a name consisting only of alphanumerical characters for the new function is entered, the script editor 

will be opened with the function identifier, begin and end markers and empty body for the new function. 

Note: A numerical character can’t be the initial character for a script function name. 

For JavaScript it looks like as follows: 

function NewFunction() { 
 // Place your function code here 
  
} 

 

For VBScript it looks like as follows: 

Sub NewFunction() 
 ' Place your function code here 
  
End Sub 

 

When the new function is finished, the script file is saved and the editor is closed, the Customization dialog 

box will be opened for asking the user to assign a shortcut key to the new function. After this assignment, the 

newly created function can be found in the list ‘Commands’ under the category “Functions” at the 

Customization dialog box via the menu command ‘Options | Customize’. Then, the function can be attached 

to a menu or toolbar whenever the user wants it. About how to execute a user script function see section 

8.2.6. 

A new script function can also be directly defined in the script editor with the function identifier, begin and 

end markers and the entire body without invoking the menu command ‘Script | Add a script function’.    

8.2.4.2 Adding an Existing Script Function 

After the script file with the function to be edited is loaded into the script editor, the existing script function 

can be edited at the editor that can be opened via the menu command ‘Script | Edit script’. 

When the editing is finished, and the user closes the editor, the Customization dialog box will not be 

presented in this case, since no new function is added. 

8.2.4.3 Removing a Script Function 
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After the script file with the function to be removed is loaded into the script editor, the existing script 

function can be removed at the editor by deleting its entire definition including its identifier, body, begin and 

end markers at the script editor. After saving the current script file and closing the editor, the function will 

be removed from the script file. Therefore, it disappears from the list ‘commands’ under the category 

“Functions” at the Customization dialog box. 

8.2.4.4 Recording a Script Function 

As a very handy starting point for creating new script functions, user’s activities can be recorded in a script 

function.  

When the menu command ‘Script | Start script recording’ is invoked, the following will be recorded as script 

statements: 

• All commands or the contents on the command line (Note: the contents on the command line is not 

always a command); 

• Most other keyboard activities; 

• Rearrangement of windows when performing multiple windows arrangement.  

When the menu command ‘Script | Stop script recording’ is invoked, the script recording will stop. Then, the 

user is asked for a new function name of the recorded script statements (consisting only of alphanumerical 

characters). After entering a name, the script editor can be opened to present the recorded results, 

depending on the configuration ‘user script editor switch on\off after recording’ at the setup, see the 

document “SetupStudio 3.0 – User Manual.doc” about it. With the configuration ‘user script editor switch on 

after recording’, the script editor will be opened when the recording is stopped. After it is closed, the 

Customization dialog box will be opened for asking the user to assign a shortcut key to the new function. For 

the configuration ‘user script editor switch off after recording’, only the Customization dialog box will be 

shown. 

When the menu command ‘Script | Start script recording’ is enabled, the menu command ‘Script | Stop script 

recording’ is disabled and has the ‘checked’ mark. That means the script recording in WinIBW3 is not yet 

started or stopped. When the menu command ‘Script | Stop script recording’ is enabled, the menu command 

‘Script | Start script recording’ is disabled and has the ‘checked’ mark. That means the script recording in 

WinIBW3 is started.  

Note: When the script recording is started, it is impossible to add a new script function. That is why the 

menu command ‘Script | Add a script function’ is disabled if the script recording is started. 

During a recording, if some copy-paste actions for making the commands in the command line take place, the 

paste action will be recorded, but not the contents of the clipboard. For example, for the command ‘find ttl 

sport’, the texts ‘find ttl’ are typed, but the text ‘sport’ is pasted after it is copied from somewhere else. Then 

the following statement will be found in the recorded script: 

application.activeWindow.command("find ttl " + application.activeWindow.clipboard, false);   

in stead of the one: 

application.activeWindow.command("find ttl sport", false);   
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8.2.5 User Script Engine 

For each scripting language (JavaScript, VBScript), there is an apart user script engine. Only when the script 

engine for the selected scripting language described in section 8.2.2 is started (On), can a user script function 

in the specified scripting language be executed.  

When the menu ‘language | From file extension’ is selected, which script engine shall be started is based on 

the extension (js or vbs) of the current user script file that is described in section 8.2.3. 

8.2.5.1 Starting the Script Engine 

After a scripting language is selected, the script engine for that language can be started with the menu 

command ‘Script | Start script engine’. When the script engine is ‘On’, the menu command ‘Script | Start 

script engine’ is disabled and has the ‘checked’ mark. When the script engine is stopped (Off), the menu 

command ‘Script | Start script engine’ is enabled. 

When the script engine is ‘On’, all the function names in the script editor will be listed in the text area 

‘commands’ at the category ‘Functions’ of the tap ‘Commands’ or of the tap ‘Keyboard’ in the Customization 

dialog box. So it is possible to attach any function in the script editor to a shortcut key, a menu item or a 

toolbar button in this case. If one of these functions is attached to a menu item or a toolbar button, this 

menu item or toolbar button is enabled and ready to execute this function. 

8.2.5.2 Stopping the Script Engine 

The script engine can be stopped with the menu command ‘Script | Stop script engine’. When the script 

engine is ‘Off’, the menu command ‘Script | Stop script engine’ is disabled and has the ‘checked’ mark.  When 

the script engine is ‘On’, the menu command ‘Script | Stop script engine’ is enabled. 

When the script engine is stopped (Off), there is no category ‘Functions’ available at the tap ‘Commands’ or 

the tap ‘Keyboard’ of the Customization dialog box. So it is impossible to attach any function in the script 

editor to a shortcut key, a menu item or a toolbar button in this case. Besides, if one of the functions in the 

script editor is attached to a menu item or a toolbar button, this menu item or toolbar button will be 

disabled. So this function can not be executed. 

8.2.6 User Script Execution 

8.2.6.1 Executing a User Script Function 

A user script function can be executed with the following 5 steps:  

• Select the scripting language in which the function to be executed is. See section 8.2.2 
about how to select a scripting language. 

• Load the script file in which the function to be executed locates. See section 8.2.3 about 
how to load a script file. 

• Attach it to a shortcut key, a menu item or a toolbar button via the Customization dialog 
box.   

• Be sure that the script engine is started. See section 8.2.5.1 about how to start the script 
engine. 

• Invoke that key, item or button. 
 

When a script contains a syntax error, the user is notified with the error location and description, and given 

the opportunity to correct the error in the script editor. In such a case, the script engine is stopped, and all 
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the menu items and tool buttons associated with the functions in the error-containing script will be disabled. 

Only when there is no error any more in the script and the script engine is manually restarted, will all the 

menu items and tool buttons associated with the functions in this script be enabled. 

For a run-time error, the user is notified with the error location and description during run-time, and given 

the opportunity to correct the error in the script editor. In that case, the script engine remains started, and 

all the menu items and tool buttons associated with the functions in the error-containing script remain 

enabled. 

8.2.6.2 Pausing and Resuming a User Script Function Execution 

A user script execution can be paused by calling the function ‘pauseScript’ from user scripts. When a user 

script execution is paused, all the sub-menu’s under the menu command Script will be disabled, except of the 

menu command ‘Script | Resume script execution’. The script recording state in WinIBW3 remains same (i.e. 

if the script recording is started before the pause, the menu command ‘Script | Start script recording’ has the 

‘checked’ mark. If the script recording is not yet started or stopped before the pause, the menu command 

‘Script | Stop script recording’ has the ‘checked’ mark.). At the pause stage of a script execution, the menu 

command ‘Script | Start script engine’ has the ‘checked’ mark, that means the script engine remains ‘On’. The 

script execution can be resumed to continue running by invoking the menu command ‘Script | Resume script 

execution’. After the script execution is resumed, all the sub-menu’s under the menu command ‘Script’ will 

come to their states before the pause. 

8.3 Standard Scripts 

WinIBW3 is packaged with a collection of standard scripts. Dailog boxes are implemented in XUL (XML User 

Interface Language) combined with Javascript.  

8.3.1 Base Standard Script Package 

The base standard script package in the distribution contains a number of sets of script functions with one 

set per one standard script file,  

However, the collection of standard scripts can be extended by the system administrator when creating the 

WinIBW3 setup. These scripts are not described here, but should be described in the site-specific User 

Manual. See the documents “Scripting in WinIBW 3” and “SetupStudio 3 – User Manual” for details 

on how to create standard scripts and include them in a WinIBW3 setup. 

In the following sub-sections, all of the functions will be described.  

8.3.1.1 File ‘standard_linking.js’ 

In the file ‘standard_linking.js’, the following functions can be found, which implement the Automatic Linking 

Function (ATF) described in section 9.1: 

• picaSearchLink 

• picaSearchLinkExact 

• picaPasteLink 

8.3.1.2 File ‘standard_kill.js’  

In the file ‘standard_kill’, the following functions can be found:  
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• picaRequestKill 

• picaSelectCorrectPPN 

• picaSelectWrongPPN 

• picaCorrectLinks 

The function picaRequestKill is a simple function to insert a specific tag into a selected bibliographic record 

indicating the so-called kill-status.  The others automate the process to replace links in a set of bibliographic 

records described in section 9.4.  

8.3.1.3 File ‘standard_copy.js’ 

In the file ‘standard_copy.js’, the following function can be found, which implements the TitleCopy function 

described in section 9.2: 

• picaCopyRecord 

8.3.1.4 File ‘standard.js’ 

In the file ‘standard.js’, the following functions can be found, which invoke the button one and the button with 

the name ‘Aide’: 

• pressButtonOne 

• pressButtonAide 

8.3.1.5 File ‘standard_create.js’ 

In the file ‘standard_create.js’, the following functions can be found, which are used to create records: 

• picaCreateAtlas 

• picaCreateAudiovisuel 

• picaCreateElectronique 

• picaCreateMonograph 

• picaCreateMultimedia 

• picaCreatePartition 

• picaCreatePeriodique 

• picaCreateSonore 

8.3.1.6 File ‘standard_transliterate.js’ 

In the file ‘standard_transliterate.js’, the following function can be found, which repeats transliterate process 

with the configured data’s that are set in the step ‘Setup transliteration’ described in section 9.2.1.1. 

• repeatTransliterate 

This function can be only used in the title ‘Insert’ mode and ‘Edit’ mode. 

8.3.1.7 File ‘standard_addNumCode.js’ 
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In the file ‘standard_addNumCode.js’, the following function can be found, which repeats adding number and 

language-code process with the configured data’s that are set in the step ‘Setup adding number and language-

code’ described in section Error! Reference source not found.9.2.2.1:  

• repeatAddNumberLanguagecode 

This function can be only used in the title ‘Insert’ mode and ‘Edit’ mode. 

8.3.1.8 File ‘standard_utility.js’ 

In the file ‘standard_utility.js’, the following function can be found, which opens a XUL dialog with error 

checks for parameters: 

• open_xul_dialog 

Besides, the following utility objects can be found in this file, which are for file input and output, and 

prompting the user during execution of scripts, and getting a special directory such as ‘ProfD’, ‘BinDir’ and 

etc.. 

• newFileInput 

• newFileOutput 

• newPrompter 

• getSpecialDirectory 

8.3.2 Standard Script Execution 

In WinIBW3, there is a script engine for standard scripts. Fortunately, it is always ‘On’ after WiniBW3 starts. 

Therefore, a standard script function can be always executed within WinIBW3.  

A standard script function can be executed with the following 2 steps:  

• Attach it to a shortcut key, a menu item or a toolbar button,   
• Invoke that key, item or button. 
•  

Usually, all of the standard script functions are included in the user interface when the site-specific WinIBW3 

setup is created. At that moment the exact location and names in the User Interface, and the optional 

shortcut keys are also defined, and thus cannot be listed here.  

8.3.3 Specials for Standard Script Execution 

8.3.3.1 Calling a Standard Script Function from User Scripts 

A function of standard scripts can be called via the function ‘callStdScriptFunction’ from a user script, see the 

document “Scripting in WinIBW3.doc” for more about this function.  

8.3.3.2 Executing a JavaScript Statement in the Command Line 

It is possible to execute a JavaScript statement during run-time by typing “!: ” in the Command Line, followed 

by a JavaScript statement in the way of standard scripts. This statement will then be executed within the 

context of the current HTML page. 
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9 Miscellanous 

9.1 Automatic Linking Function 

The automatic linking function (ATF) can be used to find the PPN’s of linked authority records, and to insert 

the link into a bibliographic record being edited. This function works in conjunction with the CBS command 

LNK. Allowed links and results of the LNK command are parameterized in the CBS standard table LNKDEF.  

The ATF function is implemented as a set of three standard functions, two for searching candidate authority 

records, and one for pasting the PPN into the record being edited. 

These three functions do the following: 

picaSearchLink: a LNK command is constructed, containing the material code of the record being edited, 

and the tag and content of the line the cursor is on. CBS performs a search with wildcards; the manner in 

which CBS searches is configurable. The result, if any, from the CBS is presented in a new Document 

Window in WinIBW3. The script function picaSearchLinkExact does the same thing, but does not expand 

wildcards when searching. 

The user is allowed to select one of the records in the result set, and invokes the script picaPasteLink, 

which copies the PPN of the record pointed at to the clipboard, closes the Document Window, automatically 

switching back to the edit screen, and pastes the PPN of the selected record into the data, optionally 

enclosed in exclamation marks. Depending on the tag, the PPN will replace the original text, or be appended 

to it. This behavior can be configured in the standard script file of WinIBW3 (when the site-specific setup is 

created). 

9.2 Transliteration Functions 

WinIBW3 supports the following 2 processes in the title ‘Insert’ and ‘Update’ mode: 

• Transliteration, 
• Adding serial number and script code.  

 
For each process, there are 2 functions: setup and repeat the process. All functions are implemented in a 

standard scripting way and can be found under the category “Standard-Functions” at the Customization dialog 

box via the menu command Options | Customize: 

• setupTransliteration 

• repeatTransliteration  

• addNumberLanguageCode 

• repeatAddNumberLanguageCode 

and each can be executed with the following 2 steps:  

• Attach it to a shortcut key, a menu item or a toolbar button,   

• Invoke that key, item or button. 

It is advised to attach each of them to a sub-menu item in the main menu TransliterationFunctions. The name 

of this sub-menu can be changed via the method described in the section 4.2.1.2. 
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The sub-menu items of the 2 setup functions are enabled after a database is selected. However, when these 2 

sub-menu items are invoked outside the title ‘Insert’ and ‘Update’ mode, only selected data’s for one process 

are saved, but the process doesn’t take place. Both processes can only take place in the title edit mode. That 

is why the sub-menu items of the 2 repeat functions are only enabled in the title edit mode.  

The syntax of transliteration might be country dependant. It is possible to specify which syntax of 

transliteration to be used when making WinIBW3 setup with SetupStudio. See the section “Syntax for 

transliteration configuration” of the document “SetupStudio 3.0 – User Manual.doc” about how to configure 

the syntax for transliteration in WinIBW3.   

9.2.1 Transliterate 

9.2.1.1 Setup Transliterate 

The configuration of the transliteration process can be done via the menu command TransliterationFunctions 

| Setup Transliterate, which opens the Transliterate dialog.  
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After a serial number in the List Box ‘Serial number’ and a combination of source and target script in the List 

Box ‘Source - Target script’ are selected, one of the following 2 actions will take place: 

• the transliteration process will be performed on all the selected text lines in the editor if the 

Checkbox ‘Insert serial number and script codes, and transliterate immediately’ is checked.  

• only the selected serial number and source and target script codes are inserted if the Checkbox 

‘Insert serial number and script codes, but transliterate later’ is checked.  

In this case, the transliteration can be performed when needed manually by users (e.g. by means of 

pressing the button ‘transliterate’) 

In both cases the selected serial number, source script, target script and the choice of when the 

transliteration takes place will be saved for the later reuse in the file ‘\transliterate\transliterateData.txt’ 

under the User Profiles. The list of all the combinations of source and target scripts comes from the CBS 

after a database is selected. Therefore, it is CBS host dependant. In case that neither the Checkbox ‘Insert 

serial number and script codes, and transliterate immediately’ nor ‘Insert serial number and script codes, but 

transliterate later’ is checked, the transliteration process will be performed immediately as default. 

The texts before transliteration, e.g.:  
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The texts after transliteration if the Checkbox ‘Insert serial number and script codes, and transliterate 

immediately’ is checked, e.g.: 
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The texts after transliteration if the Checkbox ‘Insert serial number and script codes, but transliterate 

later’ is checked, e.g.: 
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When no text line is selected, the transliteration process will be performed only on the text line where the 

cursor locates. 

When the ‘setup transliterate’ function is invoked outside the title edit mode, the following message will be 

shown. 

 

 

No matter whether the RTL function is enabled or disabled, the RTL function will be automatically enabled 

for the selected lines if either the source or target language is a RTL language when performing 

transliteration. See an example as follows: 
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9.2.1.2 Repeat Transliterate 

The standard script function repeatTransliterate can be used to repeat the transliterate process with the last 

configuration data’s for transliterate described in the section 9.2.1.1 via the menu command 

TransliterationFunctions | repeatTransliterate.   
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9.2.2 Adding Serial Number and Script Code 

9.2.2.1 Setup Adding Serial Number and Script Code 

The configuration of the adding serial number and script code process can be done via the menu command 

TransliterationFunctions | Adding serial number and script code, which opens the Adding serial number and 

script code dialog.  
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After a serial number in the List Box ‘Serial number’ and a script in the List Box ‘Script’ are selected, the 

‘adding serial number and script code’ process will be performed on all the selected text lines in the editor, 

and the selected serial number and script will be saved for the later reuse in the file 

‘\transliterate\number_languagecode.txt’ under the User Profile. The list of source scripts is retrieved from 

the CBS after a database is selected. Therefore, it is CBS host dependant. 

The texts before adding serial number and script code, e.g.: 

 

The texts after adding serial number and script code, e.g.: 
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When the ‘setup adding serial number and script code’ function is invoked outside the title edit mode, the 

following message will be shown. 

 

 

No matter whether the RTL function is enabled or disabled, the RTL function will be automatically enabled 

for the selected lines if the script language is a RTL language when performing adding serial number and script 

code. See an example as follows: 
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9.2.2.2 Repeat Adding Serial Number and Script Code 

The standard script function repeatAddNumberLanguagecode can be used to repeat the ‘adding serial number 

and script code’ process with the last configuration data’s for adding serial number and script code described 

in the section 9.2.2.1 via the menu command TransliterationFunctions | repeatAddNumberLanguagecode.  

9.3 TitleCopy Function 

The TitleCopy function can be used to copy an existing bibliographic record and paste the copied data into a 

edit screen. This function is implemented as the standard script picaCopyRecord. The exact location and 

name in the user interface, and optional shortcut keys are determined during the creation of  the site-specific 

WinIBW3 setup. 

An instructions file is used to control how the data is copied. This instructions file can be site-specific, and a 

default file is  added to the WinIBW3 distribution when the setup is created. Historically the name title.ttl is 

given to this file. 

A user can create a customized instructions file, and tell WinIBW3 to use this instead of the default file via 

the user preferences dialog. 

The next sections describe the syntax of the TitleCopy instructions file. 

WinIBW3 supports this function also for external Databases. 

9.3.1 The Instructions File 

The TitleCopy instructions file consists of a set of instructions separated by a carriage return character. Each 

instruction may contain, in order, the following: 

1. The word ALL. 

2. An indication of the position where to apply the instruction. 
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3. An operator with its arguments. 

4. An indication whether the positions are limited to a tag. 

 

[ALL] [position]* operator [WITHIN THISTAG] 

where an operator is built with following syntax: 

operator DELETE delete_arguments | INSERT insert_arguments 

delete_arguments [[FROM position] [TO position] | string] [INCLUSIVE | EXCLUSIVE] 

insert_arguments string [BEFORE position] 

position BEGFILE | ENDFILE | BEGTAG | BEGTAGCONT | ENDTAG | NEXTTAG | string | 

integer 

string [TAG] [a..z, 0..9 ]* 

integer [1..9][0..9]* 

Items between square brackets are optional. An asterisk behind an item indicates that the item occurs at least 

once. 

9.3.2 The Position Where the Instruction Is Applied 

The user can specify the position where an instruction has to be applied. This is done using one or more 

special symbols. The following symbols express absolute positions in the title: 

BEGFILE first position in the title; 

ENDFILE position after the last character in the title; 

Other symbols express positions calculated either from the beginning of the file (first symbol) or from the 

last position reached (each other symbol). This calculation works as follows: 

BEGTAG first position in the current tag; 

BEGTAGCONT first position in the current tag after the tag code (and the space); 

ENDTAG position after the last character in the current tag; 

NEXTTAG first position after the end of this tag; 

String position of the first character of the first occurrence of this string after the current 

position; if TAG is written before a string, this string is interpreted as a tag code. 

In WinIBW version 3.2, only full tag codes are matched (i.e. TAG “001” does not 

match tag 0011). In WinIBW version 3.3, the tag codes are matched according to 

Regular Expressions (i.e. TAG 001. match all 4-character strings with the first 3 

characters as 001. 

Integer the <integer>th position starting from the current position (1 means the current 

position, 2 the next one etc.). This number must be greater than 0. 

If no position is specified, then the default position is the beginning of the title. If an instruction is repeated 

(that is, begins with ALL) the position is calculated every time from the last one. 

Examples: 
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TAG "0500" BEGTAGCONT 

The beginning of the content of the first tag "0500" encountered. 

TAG "021A" "$a" 

The "$" of the first "$a" in the first "021A" encountered. 

9.3.3 The DELETE instruction 

A DELETE instruction deletes 

• a specified string 

or 

• all elements between the two positions specified after FROM and TO, including the character at the 

FROM position, but excluding the character at the TO position. 

If a string was specified, then this string is searched for in the rest of the file. The search of the string can be 

limited to a  specific tag by specifying WITHIN THISTAG. If a search was anchored between positions with 

FROM and TO,  the search can still be limited to WITHIN THISTAG. 

When the instruction contains the keyword INCLUSIVE, both characters at the FROM and TO position are 

deleted also. When the instruction contains the keyword EXCLUSIVE, both characters at the FROM and 

TO position are not deleted. 

If a  string is not specified and one or both positions is omitted, the following defaults are used: 

• FROM: the last position specified before the word DELETE. If nothing was specified before the 

word DELETE, the default position is the beginning of the file (or the last position reached in an 

ALL instruction). 

• TO: the end of the tag. 

A DELETE instruction can be combined with a subsequent INSERT instruction. 

Examples: 

TAG "0500" BEGTAGCONT DELETE FROM 3 

Makes tag "0500" empty starting from the third position of the content. 

TAG "0500" BEGTAGCONT DELETE FROM 3 TO 5 

Removes the characters at position 3 and 4 from the content of tag “0500”. 

TAG "1100" DELETE FROM "[" TO "]" EXCLUSIVE WITHIN THISTAG 

Deletes what is between square brackets in tag "1100", but not the brackets. 

TAG "1100" DELETE FROM "[" TO "]" INCLUSIVE WITHIN THISTAG 

Deletes what is between square brackets in tag "1100", and the brackets. 

TAG "1100" BEGTAGCONT DELETE 

Makes tag "1100" empty. The tag code remains. 

TAG "0599" DELETE 

Deletes the complete tag "0599" (that is tag code and content). 

ALL TAG "5050" DELETE 

Deletes all tags "5050" (tag codes and contents). 
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TAG "5530" DELETE TO ENDFILE 

Deletes all tags starting from the first "5530" (tag codes and contents). 

TAG "Ingevoerd:" DELETE 

Deletes the header line that may be included in the copied record. 

TAG "20.." DELETE 

Deletes all of the complete tags matching “20..” according to Regular Expressions. 

 

The INSERT instruction 

The INSERT instruction inserts a string at the position specified after BEFORE. If no position is specified 

the default position is: 

• for a tag (ex. TAG "0051" ) the right place in the title, so that the tags are sorted; 

• for other strings the last position specified before INSERT. If before INSERT nothing was 

specified, the default position is the beginning of the title (or the last position reached in an ALL 

instruction). 

An INSERT instruction can be combined with a DELETE instruction. 

Examples: 

INSERT TAG "0701" 

Insert the string “0701" after all tags with a smaller or equal tag code. 

TAG "1100" BEGTAGCONT INSERT "1997" 

Insert the string "1997" directly after the code (and space) of tag "1100". 

ALL TAG "2009" BEGTAG DELETE TO 5 INSERT "2001" 

Deletes only the tag code itself (not the contents), inserts "2001 " instead. 

TAG "424." INSERT "WinIBW" BEFORE 3 

Insert string “WinIBW” before the third character of the contents at all the tags matching “424.” according to 

Regular Expressions.  

ENDFILE INSERT "..." 

Inserts three dots at the end of the data (can be used to prevent accidental creation of a new record). 

9.4 Replacing links 

A set of three standard scripts is available for automating the steps necessary to execute the procedure for 

replacing links to authority records in bibliographic records online.  

The first step consists of determining what the “correct” record is, by pointing at the preferred record (in a 

short or Full Presentation screen, after a search command if necessary) and executing 

picaSelectCorrectPPN. 

The next step consists of determining what the “wrong” record is (the link to which is to be replaced by a 

link to the correct record), by pointing at this record and executing picaSelectWrongPPN when it is 

found. 

The final step is searching for the set of records that contain links to the “wrong” record, by issuing the 

command REL TT(while the “wrong” record is still selected). This results in a set of all records that contain 

a link to the “wrong" record that must be replaced by a link to the “correct” record. This set can now be 
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processed via the script function picaCorrectLinks, that first gives a short explanation of what it is about to 

do, and then proceeds with replacing the wrong PPN by the correct PPN in each of the records in the set, 

and submitting the changes to the central system. 

9.5 Advanced Search 

Both the menu command File | switch to advanced search screen and tool bar item switch to advanced search 

screen can be used to get the title advanced search screen. The tool bar item ‘switch to advanced search 

screen’ is enabled only after one database is selected. 

 

9.6 Online help 

In WinIBW3 there are two standard help mechanisms available: 

• Help about the command syntax 

• Cataloging Help 

• ILL Document 

By creating special standard scripts it is possible to extend the help interface, for example to the cataloging 

guidelines of other system. These are site-specific additions to the WinIBW3 setup that are not described 

here. 
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9.6.1 Command syntax 

The help for the command syntax is based on information provided by the remote system, and is activated 

the command \HEL. This command can also be executed by pressing the Help button available on almost all 

screens. 

 

 

 

A screen will appear presenting a list of commands for which a help page is available. The selected help page 

is presented by WinIBW3 in the current Document Window. The help pages usually contain links to other or 

related help pages. 

9.6.2 Cataloging help 

When the menu command ‘Help | Cataloging Help’ is invoked or the button ‘F1’ is pressed before the 

successful connection with a CBS system, a default link to Guidelines for cataloguing, which is specified at the 

WinIBW3 setup, will be opened.  

The site-specific online cataloguing help, which can be different from the default one, is also supported, if the 

site-specific online cataloguing help parameters exist in the connected CBS system. Otherwise, the default 

cataloguing help will be used. The site-specific online cataloging help can be active only after a successful login.  
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When the user is editing a bibliographic record, WinIBW3 is capable to retrieve context sensitive help 

screens in the standard browser, by constructing URLs that contain the tag code of the line in the editor 

where the cursor is located. The exact structure of these URLs is determined when the site-specific setup of 

WinIBW3 is created, and help pages must be available at these URLs. WinIBW3 can also distinguish between 

tags of bibliographic records and authority records, and construct different URLs. When WinIBW3 cannot 

determine the tag code, or when the edit screen is not activated, a URL referring to an index page is 

generated.  

See the document “SetupStudio 3.0 – User Manual.doc” for more about how to configure the default and 

site-specific online cataloguing help. 

9.6.3 Document ILL 

When the menu command ‘Help | ILL Document’ is invoked, a default link to Library Information Delivery 

Service, which is specified at the WinIBW3 setup, will be opened.   

See the document “SetupStudio 3.0 – User Manual.doc” for more information about how to configure 

document ILL. 

9.6.4 About WinIBW 

When the menu command ‘Help | About WinIBW…’ is invoked, the WinIBW Info and its release information 

including credits and licensing related to third-party software can be found as follows: 

  

9.7 Startup file 

9.7.1 URL 

The format of the URLs to connect to a CBS or LBS system is: 

pica3://<server>:<port> 



 

project:  

document name: WinIBW3 Product Description 

version: 2.7 

 

  

Date 18-11-2013 page 95 of 126 

 

9.7.2 Images 

The mechanism to include images from the default images location is: 

SRC="resource:/images/<filename>" 

Images that have to be included in the WinIBW3 distribution should be placed in this directory. 

9.7.3 Dynamic loading of the startup file 

Traditionally the startup file is part of the WinIBW3 setup, which makes it difficult to distribute changes to 

the startup file. WinIBW3 allows for a more flexible approach, where the startup file that is distributed with 

the WinIBW3 setup redirects to a startup file that resides on a central web server. This can be modified as 

required, and all users will automatically see the updated startup file the next time they start WinIBW3. 

The startup file contained in the WinIBW3 setup should look something like this (with thanks to our 

colleagues from BSZ): 

<HTML> 

<HEAD> 

<meta http-equiv="refresh"  

      content="0; url=http://server:port/cgi-bin/real-startup-filename/"> 

<TITLE></TITLE> 

</HEAD> 

<BODY></BODY> 

</HTML> 

 

9.8 Table Function 

Here, a table consists of a list of possible values for a specific tag. As a cataloguing aid, the Table Function is 

used to: 

• offer a list of possible values for a specific tag,  

• replace a shortcut (entered by a cataloguer) with a value defined in a table, or insert the value for a  

specific tag.  

Therefore, the following 2 issues are involved in the Table Function: 

• Editing tables: 

How to make a list of possible values for a specific tag. 

• Using tables:  

How to replace a shortcut (entered by a cataloguer) with a value defined in a table or to insert the 

value for a specific tag.   

9.8.1 Editing tables 

After pressing the sub-menu ‘Edit tables…’ under the main menu ‘Options’, the ‘Edit Tables’ dialog will be 

shown with: 

• All default and user-defined tables in the ‘Available tables’ list-box, see Section 9.8.3 about default 

and user-defined tables,  

• The tag, description and elements of the selected table in the ‘Overview’ group, 
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• The contents of the selected element in the ‘Element’ group.  

 

This dialog allows a user to create a new table, modify or delete an existing one. 

9.8.1.1 Creating a new table 

When pressing the button ‘New Table’ in the ‘Edit tables’ dialog, the following dialog will be shown: 

 

After specifying a tag and pressing the button ‘OK’, the following dialog will be shown: 
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After providing a description and pressing the button ‘OK’, a table file with filename ‘xxx_yyy.tab’ will be 

created in subdirectory ‘Tables’ under the user profile directory, where xxx is the specified tag and yyy is the 

provided table-description mentioned above and the ‘Edit Tables’ dialog will be as follows (e.g. the specified 

tag and table description are 0501 and 0501Table1, respectively): 

  

So, it is possible to create more than one table for one tag.   

Note: the tables with file name of xxx.tab will be automatically converted to the tables with file name of 

xxx_yyy.tab when pressing the sub-menu ‘Edit tables…’ under the main menu ‘Options’.  

An element of a table consists of a shortcut, text to be inserted in the cataloging screen and an optional 

description for this element. The contents of the element can be edited as follows: 
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• Creating a new element if the ‘Content’ area in the ‘Overview’ group is empty: 

Filling the ‘Shortcut’, ‘Description’ and ‘Text to insert’ fields in the ‘Element’ group and pressing the 

button ‘Insert’, the created element will be shown in the ‘Content’ area of the ‘Overview’ group. 

• Inserting a new element: 

Selecting an element in the ‘Content’ area, filling the ‘Shortcut’, ‘Description’ and ‘Text to insert’ 

fields in the ‘Element’ group and pressing the button ‘Insert’, the created element will be added 

directly after the selected element in the ‘Content’ area.    

• Updating an existing element: 

Double-clicking an element in the ‘Content’ area, all the fields in the ‘Element’ group will be filled 

with the current values of the selected element. Changing any entry in these fields and pressing the 

button ‘Update’, the contents of the selected element will be updated with the new values. 

• Removing an existing element: 

Selecting an element in the ‘Content’ area and pressing the button ‘Remove’, the selected element 

will be removed from the ‘Content’ area.    

 The order of elements in the ‘Content’ area can be made by the following ways: 

• Moving up an element by pressing the button ‘Move up’, 

• Moving down an element by pressing the button ‘Move down’, 

• Sorting elements on shortcut by pressing the button ‘Sort on Shortcut’, 

• Sorting elements on content by pressing the button ‘Sort on Content’. 

When pressing the button ‘Save Table’ in the ‘Edit tables’ dialog, any update mentioned above will be saved in 

the new table file. 

9.8.1.2 Modifying an existing table 

After selecting a table from the ‘Available tables’ list-box in the ‘Edit tables’ dialog, all the fields in both the 

‘Overview’ and ‘Element’ group will be filled with the current values of the selected table.  

When pressing the button ‘Save Table’ in the ‘Edit tables’ dialog, the updates for any field of the selected table 

will be saved. See how to update the table-contents in Section Error! Reference source not found.9.8.1.1.  

When pressing the button ‘Save Table As…’ in the ‘Edit tables’ dialog, followed by specifying a tag and 

providing a description for a new table file, the updates for any field of the selected table will be saved in the 

new table file. 

For one selected table,  

• Change either tag or table description, or both of them: 

The old table will be deleted and a new table with the specified tag and/or the specified table 

description will be created after pressing either the 'save as' button or the 'OK' button.  

• Only change the contents of the table, the table will be updated with the changed contents after 

pressing either the 'save as' button or the 'OK' button. 

9.8.1.3 Deleting an existing table 

After selecting a table from the ‘Available tables’ list-box in the ‘Edit tables’ dialog and pressing the button 

‘Delete Table’ in the ‘Edit tables’ dialog, the selected table will be deleted after pressing the button ‘OK’ on 

the message-box with the message ‘Are you sure to delete the table?’. 
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If a selected table is a default one, the button ‘Delete Table’ in the ‘Edit tables’ dialog will be disabled because 

the default tables can’t be deleted by a user, see Section 9.8.3 about user-defined and default tables. 

9.8.2 Using tables 

In the title editor, the tables can be invoked by the following 2 ways: 

• Pressing the sub-menu ‘Table’ under the main menu ‘Edit’ 

• Pressing the short-cut ‘Ctrl+T’ 

There are several ways to use tables: 

• When entering a tag code and invoking tables, the dialog ‘Available tables for one tag’ will be present, 

showing the tag, table description and file name with one table per line: 

 
 

After double-clicking a table, a popup dialog box for the table is presented, showing a list of 

shortcuts, texts to be inserted, description with one element per line: 

 

 
 

After double-clicking an element, its text (i.e. the text on the second column) will be entered after 

the tag code in the title editor. 

• When entering a tag code and a short-cut, and then invoking tables, the dialog ‘Available tables for 

one tag’ will be shown as the way mentioned above if the short-cut doesn’t exist in any table 

for the tag. 

• When entering a tag code and invoking tables, the corresponding text for this tag will be immediately 

entered after the tag code if the tag code itself is a short-cut which exists only in one table.  

• When entering a tag code and a short-cut, and then invoking tables, the short-cut will be immediately 

replaced with the corresponding text to this short-cut if the short-cut exists only in one table.  
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•  When entering a tag code and a short-cut, and then invoking tables, the short-cut will be 

immediately replaced with the corresponding text to the short-cut, which is in the first table 

(alphabetical order )of all the tables with this short-cut, if the short-cut exists in more than one 

table (both user-defined and default) for the tag.  

• When highlighting a part of tag-content, and then invoking tables, the table for the concerning tag will 

be present.  After double-clicking an element, the highlighted text will be replaced by the text at the 

selected element.  

E.g. ‘red’ in the following tag-content is highlighted and then replaced by $edt$ as follows: 

3011 Dirk@Kramerred!012345678! 

3011 Dirk@Kramer$edt$!012345678! 

• If $-signs are used in the tag-content but no text of the tag-content has been highlighted, and then 

tables are invoked, the table for the concerning tag will be present.  After double-clicking an 

element, the text between the last $-sign before the cursor and the cursor (including the $-sign) will 

be replaced by the text at the selected element.  

E.g. the cursor locates between ‘red’ and ‘!012345678!’,  the $red will be replaced by $edt$ as 

follows: 

3011 Dirk@Kramer$red|!012345678! 

3011 Dirk@Kramer$edt$!012345678! 

E.g. the cursor locates between the $-sign and ‘!012345678!’, the $-sign will be replaced by $act$ as 

follows: 

3011 Dirk@Kramer$|!012345678! 

3011 Dirk@Kramer$act$!012345678! 

• If neither a $-sign is used in the tag-content nor text of the tag-content has been highlighted, and 

then tables are invoked, the table for the concerning tag will be present.  After double-clicking an 

element, the text between the last space before the cursor and the cursor (including the space) will 

be replaced by the text at the selected element. 

E.g. the cursor is after ´med´ and ´ med´ will be replaced by $act$ as follows: 

3011 Dirk@Kramer med|!012345678! 

3011 Dirk@Kramer$act$!012345678! 

E.g. the cursor is after a space and the space will be replaced by $act$ as follows: 

3011 Dirk@Kramer |!012345678! 

3011 Dirk@Kramer$act$!012345678! 

 

Note 1: When no text of the tag-content is highlighted and there are no $-signs or spaces in the tag-content,   

and then the tables are invoked, all data (except the tag code) will be taken as a short-cut and replaced with 

the chosen entry or the corresponding text. When having highlighted a part of the data, only the selection 

will be taken as a short-cut and replaced. 

E.g. the ‘A’ will be taken as a short-cut and replaced with the chosen entry as follows: 

1110 A 

1110 Ab004 

Note 2: The tables are specific for a tag code, but may contain the wildcard ‘X’ to match several similar tags. 

E.g. the table for tag 420X will be used for all tags from 4200 to 4209 (unless there is also a specific table for 

one of these tags). 
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9.8.3 User-defined tables and default tables 

The tables residing in subdirectory ‘Tables’ under User Profile directory are the user-defined tables, which 

can be created, modified and deleted by a user, see Section 9.8.1 about how to do that.   

The tables residing in subdirectory ‘tables’ under WinIBW3 installation directory are the default tables, which 

are created by the system manager (in the way of making user-defined tables) and added to WinIBW3 at a 

WinIBW3 setup. The default tables can’t be deleted by a user. Besides, any change of a default table will be 

saved in the copy table file of the default table in subdirectory ‘Tables’ under User Profile directory. 

From a table-using point of view, the difference between the user-defined and default tables will not be seen. 

Every time when opening the ‘Edit tables’ dialog, all the user-defined and default tables will be in the list of 

‘Available tables’.  

Note: Both user-defined and default table has to be saved in the ‘UTF-8’ format. 

9.9 Update Service  

The WinIBW3 Update Service updates (and possibly adds, and/or deletes) files (e.g. standard script files, XUL 

objects, localization and etc.) in the WinIBW3 installation directory with the files in a central location usually 

on a web server. 

To enable updates, the value of preference "ibw.updateservice.url" has to be set to the location 

where all the source files reside. See the section “Update Service” of the document “SetupStudio 3.0 – User 

Manual.doc” about how to set the value of this preference at a WinIBW3 setup and see section 4.1.2.3 about 

hot to change the value of this preference in WinIBW3. When this preference is not set or incorrectly set, a 

warning message will be shown: 

 

 

And no update will take place. Besides, a file containing the update specification with the name of 
“update.xml” has to be available in the same location. 
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9.9.1 Update specification file 

The structure of the file “update.xml” has to be as follows: 

<?xml version="1.0" encoding="ISO-8859-1"?> 

<WinIBW3UpdateService> 

  <update date="yyyymmdd"> 

    <file source="src_filename1" destination="dest_filename1" /> 

    <file source="src_filename2" destination="dest_filename2" /> 

  </update> 

<update date="yyyymmdd"> 

    <file source="src_filename3" destination="dest_filename3" /> 

    <file source="src_filename4" destination="dest_filename4" /> 

    <file source=""              destination="dest_filename5" />  

  </update> 

</WinIBW3UpdateService> 

 

Here, the <update> element is repeatable, and contains the attribute date. This date is formatted as 

“yyyymmdd”. This date is compared with the date, which is the date of the last update and saved with the 

format of “yyyymmdd” in the file “winibw.txt” under WinIBW3 installation directory. Only updates with a 

date later than the date of the last update are processed. 

The <file> element is repeatable within the <update> element, and describes the file to be downloaded. It 

consists of the attributes source and destination. The source file name is relative to the URL specified in 

the preference "ibw.updateservice.url". The destination file name is relative to the WinIBW3 

installation directory. Both names can contain subdirectories by using a slash or backslash, and must not start 

with a slash or backslash. Besides, the source and destination file names and paths do not have to be the 

same. If it is specified with source="", the file in destination will be deleted by the update service.  

Warning: The delete feature of the update service on Windows 7 workstations requires users to have 

administration rights.  

Notes about the file “update.xml”: When the 'update.xml' file is changed on the server, WinIBW3 doesn't 

react to its changes. In this case, the action ‘Delete browsing history’ on Internet explorer at the users’ 

machine needs to be done so that WinIBW3 can read updated ‘update.xml’ to perform specified updates.  

Notes about the file “winibw.txt”:  

• The file ‘winibw.txt’ with its contents ‘00000000’ will be provided as one file of WinIBW3 distribute 

package under the ‘bin’ directory. Don’t delete this ‘winibw.txt’ with its contents ‘00000000’ when 

making a WinIBW3 setup. 

• After installation and before run WinIBW3, the file ‘winibw.txt’ is already under WinIBW3 

installation directory. 

• If the content of the file ‘winibw.txt’ is ‘00000000’, WinIBW3 knows it is the first run after WinIBW3 

installation and then take some action (deleting some old files in user profile location) and change the 

content of the file ‘winibw.txt’ into ‘19990101’. 

• If no update need or a failure update, the content of the file ‘winibw.txt’ remains ‘19990101’. For a 

successful update, the content of the file ‘winibw.txt’ is updated with current data. 
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9.9.2 Update at WinIBW3 start-up 

Once a day, WinIBW3 inspects the file “update.xml” to compare the update dates with the value of the 

preference "ibw.updateservice.lastdate" during start-up. When an update date is later than the 

date of the last update, updates are processed. Then, the value of the preference 

"ibw.updateservice.lastdate" will be updated with the current date. If no update is needed, the 

value of the preference "ibw.updateservice.lastdate" is unchanged. With a failure update, an 

update report with a list of all unsuccessful files for update will be presented. See the following as an example:  

 
and the message “update failed!” will be shown. In this case, the value of the preference 

"ibw.updateservice.lastdate" remains same. 

Updates can also be performed within WinIBW3, see section 4.1.2.34.1.2.4 for more about it. 

 

9.10 Serial Communication 

WinIBW3 can optionally write the messages it receives from CBS to a serial port. Every message is written 

on a new line. 

The serial port cannot be opened if it is already in use by another application (including WinIBW2).  

Messages can contain all ASCII characters (including characters with accents and umlauts), but not Unicode 

characters. 

To enable this feature, two preferences must be set in the WinIBW setup: 

• "ibw.serialcomm.port" indicates the port, e.g. “COM1”; 

• "ibw.serialcomm.mode" contains the mode parameters, e.g. "9600,n,8,1". 

When WinIBW3 cannot open the port, or does not understand the mode parameters, an error message is 

displayed, and the port is not opened. 

9.11 Trace and Source window 

WinIBW3 provides two functions that can be used for analysis of problems:  

• Source window 
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• Trace window 

Both functions are not necessarily available in site-specific WinIBW3 setups, but can be added to the user 

interface when needed (see section 4.2 how to add functionality to the user interface). They can be found in 

the category View functions on the Commands tab in the Customization dialog box. 

9.11.1 Source window 

The source window shows the internal HTML code of the current Document Window to allow WinIBW3 

developers, experienced users or site administrators to inspect the internal HTML code of the displayed page. 

 

The edit functionality (Find, Copy and Select All) is provided in this window. These functions can be activated 

by right-click on the mouse in the source window or pressing well-known standard short-keys for them. 

The source window can be resized and with Alt-F4 closed. 
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9.11.2 Trace window 

 

The Trace window allows the inspections of three types of data streams: 

• Internal Gecko 

• Server Traffic 

• Protocol Handler 

By checking a combination of these three traces, the data streams can be inspected while working with 

WinIBW3. The window can be minimized to allow working with WinIBW3, and will show the selected trace 

when maximized again. When the window does not occupy the entire screen, it is possible to work with 

WinIBW3 when the Trace window is also on the screen. 

The edit functionality (Find, Copy, Select All and Clear Trace) is provided in this window. These functions can 

be activated by right-click on the mouse in the trace window or pressing well-known standard short-keys for 

them. The short-key ‘Ctrl+D’ is for Clear Trace. 

In particular, Server Traffic trace can be of interest, since it shows the data between WinIBW3 and the 

remote system with the date and time stamp for each entry. It is possible to truncate the screen and/or 

template definition of service traffic by checking a combination of 

• Truncate Screen 

• Truncate Template 
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9.12 Field variable retrieval 

When a user puts the cursor into a field and press the keys: Ctrl+Shift+n, the name of the variable relating to 

that field will be shown. E.g. When a user puts the cursor into the field ‘Login’, the name of the variable for 

the field ‘Login’ will be shown as follows: 

 

 

9.13 Connect to CBS by arguments on command line 

WinIBW3 can be started on the command line and directly connect to a specific CBS environment by 

specifying a specific CBS environment on the command line. The syntax of the command must be as follows: 

WinIBW3.exe -u:xxx,-n:yyy,-p:zzz 

where xxx is the url of the CBS environment to connect to, yyy and zzz are, respectively, username and 

password to access to the environment. 

 

e.g.  

Executing “WinIBW3.exe -u:pica3//cbs-acc.pica.nl:1028” on the command line will directly go to the login 

screen of the specified CBS environment. 

 

Executing “WinIBW3.exe -u:pica3//cbs-acc.pica.nl:1028, -n:zhangj, -p:zhangj” on the command line will directly 

go to the system selection screen of the specified CBS environment. 

This feature will be very handy for the deployment of WinIBW3 on a server. 

9.14 Working with LBS4 

WinIBW3 can be started by executing “WinIBW30.exe -u:xxx, -n:yyy, -p:zzz, -e:iii” on the command 

line, where  

• xxx is the url of a CBS server,   

• yyy is a user CBS key that will be used to automatically log into 

• zzz is the CBS password of user yyy 

• iii is the url of the location where WinIBW3 will send the EPN information to, formatted like this:  

“ http://<server>:<port>/EPNCache/cache?SID=<sid>”  

(Here, <sid> is the LBS session ID, as defined by the sending LBS system) 

In WinIBW3, the button ‘send EPN to LBS’ on the toolbar will be used specially for LBS4. Only when the 

following pre-conditions are met, shall the special LBS4 button be enabled: 
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• WinIBW3 is in the long presentation; 

• At least one ‘epn’ is present in a selected title; 

• The extra info is provided from LBS4. 

In all other cases, the special LBS4 button will be disabled. In case that the special LBS4 button is enabled and 

after it is pressed, the largest ‘epn’ in the title (if more than one ‘epns’ are present. In principle, the largest 

‘epn’ is also the latest ‘epn’) will be appended to the extra info provided by LBS4 and the extra info + 

&EPN=<epn>, i.e. 

“http://<server>:<port>/EPNCache/cache?SID=<sid>&EPN=<epn>” 

will be sent back to LBS4 by WinIBW3. After the successful sending, the special LBS4 button will be disabled 

again, because only one ‘epn’ can be sent to LBS4. 

Note: The special LBS4 button is associated with the function ‘sendEPNToLBS’ of the WinIBW3 standard 

scripts. So, the button can be made when making site specific WinIBW3 GUI. 

9.15 WinIBW3 error logging during start-up 

Every time when WinIBW3 starts up, a file with the name "winibwERRORLog.txt" will be created in "C:\" 

after the old file "winibwERRORLog.txt" is removed in case it exists. 

If something goes wrong during WinIBW3 start-up  (i.e. during the WinIBW3 initialization process), the 

problem(s) will be logged in the file "C:\winibwERRORLog.txt". Currently, the following errors are logged:  

• WinIBW3 can't start because another instance of the application is already running.  

• Start-up page **** is not valid!   

• All kinds of Update errors. 

This feature can be On/Off at WinIBW3 setup. Please see section ‘WinIBW3 start-up error logging 

configuration’ of the documentation “SETUPSTUDIO 3.0 User Manual” about how to turn this feature on or 

off. 

9.16 Focus switch between ‘view’ and command line 

Pressing 'Alt+c' will move focus on command line.  

Pressing 'Alt+i' will move focus on ‘view’. (Here, ‘view’ can be title editor or short presentation list or other 

lists, depending on which one is on the window). In case of 'short presentation list', pressing either  ‘Alt+i’ or 

‘Alt+l’ (Here, I is the lower case of ‘L’, not the upper case of ‘i’) will move focus on 'short presentation list', 

because pressing ‘Alt+l’ will move focus on short presentation list and ‘Alt+i’ will, in general, move focus on 

view including short presentation list.  

During script recording, pressing 'Alt+c' (to activate command line) and either 'Alt+i' or ‘Alt+l’ (to activate 

‘view’) will be recorded in the script. 



 

project:  

document name: WinIBW3 Product Description 

version: 2.7 

 

  

Date 18-11-2013 page 108 of 126 

 

10 Differences between WinIBW2 and  WinIBW3 

10.1 Unicode 

The ability to display Unicode characters and use them in the cataloging process is the most important 

difference between WinIBW2 and WinIBW3, and was, in fact, the primary motivation behind the 

development of WinIBW3. 

10.2 Presentations 

10.2.1 Full Presentation 

• Text in the Full Presentation screen can directly be selected with the mouse and copied to the clipboard. 

Therefore the WinIBW2 function Edit > Select and Copy… no longer exists. 

• Syntax coloring for full presentations is now supported. 

10.2.2 Deduplication screen 

• The differences are not shown per complete tag, but inside one tag the differences and similarities are 

shown. 

• It is no longer possible for the user to adapt the width of the two records displayed. 

10.3 User interface 

10.3.1 User preferences 

It is possible to change the typeface and typeface settings of the Message Bar and the Special Characters Bar. 

10.3.2 New UI functions 

File > Default start page opens the default start page. 

10.3.3 Obsolete UI functions 

The following functions do not exist anymore in WinIBW3. Note that some of the functions were not part of 

the default menu structure, and may therefore be unfamiliar. 

File > New 

File > Upload… 

Edit > Select and Copy… 

View > Raw 

View > STCN 

View > MBCS 

Options > Auto Load Images 

Options > Customize Toolbar… 

Options > Send Problem Report… 
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Help > Tip of the Day  

In addition, the entire Macro menu does no longer exist. 

10.3.4 Command Bar 

The Command Bar no longer contains a button for activating the History List. 

The Command Line now has an autocompletion feature. 

The command history is maintained between WinIBW3 sessions. 

10.3.5 Message Bar 

The Message Bar can no longer be made persistent (i.e. visible when there is no message to show). 

10.3.6 Auto-repair 

The auto-repair functionality has been removed, although it is still possible to revert to the default user 

interface configuration, or the last saved configuration. 

10.4 Startup file 

WinIBW2 startup files cannot be used by WinIBW3. In particular, the URL to connect to a CBS or LBS has 

changed. 

10.4.1 URL 

The format of the URLs to connect to a CBS or LBS system has changed. The format now is: 

pica3://<server>:<port>[-<port>]> 

The WinIBW2 URL looked like: 

LASP:///ibw/Host=<host>&Port=<port>[-<port>][&mode=direct]/start 

10.4.2 Images 

The mechanism to include images from the default images location has changed. Where WinIBW2 used  

SRC="file:///[images]/oclcpica.gif" 

WinIBW3 uses 

SRC="resource:/images/oclcpica.gif" 

10.5 Scripting 

See the document Scripting in WinIBW3 – Getting Started for more details concerning Scripting in 

WinIBW3. 

10.5.1 Script languages 

WinIBW2 supported Visual Basic Scripting (VBS) for both user scripts and standard scripts. 
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WinIBW3 still supports VBS for user scripts, but standard scripts now have to be in Java. Script User scripts 

can also be in JavaScript, but only one script language can be selected for a specific WinIBW3 setup (this will 

be a setting in SetupStudio3). 

VBS should only be used where backward compatibility is needed. Scripting with JavaScript is recommended. 

10.5.2 Inserting new lines 

vbCR does not function as in WinIBW2. Use vbLF instead. 

10.6 Printing 

Several additional settings can be specified for printing, such as margins, orientation, headers and footers. 

Furthermore, for different print types different settings can be used (this only applies when the \PRI command 

is used). 
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Appendix A WinIBW3 Script IDE 

A.1 Introduction and Background 

WinIBW3 provides scripting functionality to automate repeated tasks. Main purpose of the Scripting IDE 

(Integrated Development Environment) is to let users efficiently make use of scripting feature of WinIBW3. 

In the previous versions of the WinIBW3 Unicode text was not handled. One of the main features of new 

scripting IDE is Unicode support. 

Using scripting IDE, users can create new files, load existing files, and save files. Scripting IDE provides 

standard editing functions i.e. cut, copy, paste, find text, and replace text.  The details of the IDE functionality 

are explained in the following sections by going through all the menu items. 

Scripting IDE can be opened in several ways within WinIBW3. From Script->Edit script menu you can directly 

edit the last open script. You can click on “Script->Add a script function” menu and a function name input 

dialog is displayed. Afterwards, an empty function is added to the last opened script. Another way of opening 

the script editor is to start “Script->Start script recording” i.e. recording a script, when recoring finishes add 

function procedure is followed but this time function body contains the recorded script statements. Finally, 

while a script function is executed, if a script error occurs scripting IDE is opened. 

A.2 IDE Window’s General Layout   

The scripting IDE window has four main parts: title, menu, editor, and status bar.  

Title displays the file path and name of the script being edited. An asterisk “*” is added whenever script has 

any modification that is not yet saved. For default files “<Default>” text is displayed. 

Menu contains actions that can be accessed with mouse or keyboard shortcuts for certain menu items. 

Editor is where the text is manipulated. Editor provides syntax highlighting to increase readability. You can 

adjust the font size from Edit menu. 

Status bar has four subsections, message, font information, source location information, and current scripting 

language. Font and source location information is updated every time cursor position changes. 
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A.3 Menu Items 

All of the functionality of scripting IDE is accessible by menu items. In the following subsections each menu 

item is explained. 

Below is the expanded view of menu items. 
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Menu Item Name and Location Description 

File-> (New, Load, Save, Save as, 

Exit) 

These are typical editor commands to perform named actions.  

Exit closes the window.  

When current file has modifications editor asks for save if New, Load 

or Exit is selected. 

For Load, Save and Save as, the location of the user profile will pop up as 

the first choice. 

Note: It is possible for WinIBW3 to load a script (located in the shared 

location of network driver, e.g.) with ‘read-only’ permission for a user 

who has no write permission for this shared location.  

File->Open default Depending on current language opens or creates (if default file does not 

already exist) the default file. If current language is “JavaScript” winibw.js 

is opened. If current language is “VBScript” winibw.vbs is opened. 

Edit->(Undo, Redo) Editor creates an undo buffer for each text modification. Buffer actions 

can be Undone and Redone using the menu items. 

Edit-> (Cut, Copy, Paste, Select 

All, Find, Replace) 

These are typical editor commands to perform the named actions. 

Edit->Goto line Pops up a dialog to enter a line number to put the cursor on.  
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Edit->(Font size, Increase font 

size, Decrease font size, Font) 

You can select a font size for the editor text by using these menu items. 

You can select font between ‘Arial Unicode MS’ and ‘Calibri’. The default 

font is ‘Arial Unicode MS’. With ‘Calibri’, Unicode characters can be 

displayed. 

Edit->Syntax check Performs a syntax check based on the current language (displayed in the 

status bar). Note that syntax check is less strict than run-time checks, so 

it does not guarantee that your scripts will run. 

Edit->Syntax coloring You can enable/disable syntax coloring using this menu item. Syntax 

coloring can take a long time for huge files (a progress message will 

appear in such cases). 

Language->(JavaScript, VBScript) Sets the current scripting language. Updates syntax highlighting.  

When you set “Language->VBScript”, or “Language->JavaScript”, current 

language is forced to VBScript or JavaScript correspondingly. 

If current editor file is a default file “winibw.vbs”, or “winibw.js”, and you 

change the language the editor changes the file too. 

Language->From file extension When this is selected, current language (displayed in the status bar) is 

determined by the script file extension. If extension is “js” language is set 

to JavaScript. If extension is “vbs” language is set to VisualBasic Script. If 

extension is something else JavaScript is set as the current language (you 

can select Language->VBScript to force VisualBasic). 

Note that WINIBW3 executes scripts in the language that is displayed in 

the status bar. 
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Appendix B  Keyboard layouts and Input Method Editors 

WinIBW 3 supports the standard Windows tools for entering Unicode data, such as Input Method Editors 

(IME) for Japanese, Chinese and Korean, and keyboard layouts for Arabic, Russian, Hebrew etc. 

This appendix describes how to install additional language support, keyboard layouts and IMEs. 

These components are part of Windows 2000 and Windows XP, although not installed by default. For 

Windows 98SE, NT4-SP6 and ME Microsoft provides the Global IME 5.02 for 32-bit Windows or the 

Global IME 5.02 for Office XP, that contains IMEs for the East Asian languages. 

 

NOTE: To perform these procedures, you may have to be a member of the Administrator group on the local 

computer, or you must have been delegated the appropriate authority. If the computer is within a domain, 

members of the Domain Administrator group might be able to perform this procedure. 

B.1 Windows XP 

Under Windows XP and 2000, the first step is to add supplemental language support, for complex script, 

right-to-left languages and for East Asian languages. The complex script and right-to-left languages include 

Arabic, Armenian, Georgian, Hebrew, the Indic languages, Thai, and Vietnamese; the East Asian languages 

include Chinese, Japanese, and Korean. The files for most other languages are installed on your computer 

automatically by Windows. 

See also: http://www.microsoft.com/globaldev/handson/user/xpintlsupp.mspx 

B.1.1 Add Language Support 

1. Open the Control Panel. 

2. Click on Date, Time, Language and Regional Options. 

3. Click on Regional and Language Options. The Regional and Language Options applet appears. 

4. Click on the Languages tab. 

5. Under Supplemental language support, select the check box beside the applicable language 

collection: 

• Install files for complex script and right-to-left languages, and  

• Install files for East Asian languages 

6. Click OK or Apply. You will be prompted to insert the Windows CD-ROM or point to a network 

location where the files are located. After the files are installed, you must restart your computer. 

B.1.2 Add Keyboard / Input Method Editor 

1. Follow steps 1 – 4 from Add Language Support. 

2. Under Text services and input languages, click on Details… 

3. Under Installed services, click on Add… 

4. In the Add Input Language dialog box, select the input language and keyboard layout or IME you want 

to add. Click OK to exit 
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5. Repeat steps 3 and 4 to add more input languages. Once done, click OK to close Text services and input 

languages, and click OK to close Regional and Language Options. 

6. You should now see a language indicator in the System Tray (located at bottom right hand corner of the 

desktop by default). You can switch between different input methods by pressing the left Alt + Shift keys 

or the right Alt + Shift keys 

B.2 Windows 2000 

See also: http://www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx 

B.2.1 Add Language Support 

1. Open the Control Panel. 

2. Click on Regional Options. The Regional Options applet appears. 

3. On the General tab, under Language settings for the system, select the check box next to the language 

group(s) you want to install. 

4. Under Supplemental language support, select the check box beside the applicable language 

collection: 

5. Click Apply. You will be prompted to insert the Windows CD-ROM or point to a network location 

where the files are located. After the files are installed, you must restart your computer. 

B.2.2 Add Keyboard / Input Method Editor 

1. Click on Regional Options in the Control panel. 

2. Click on the Input Locales tab. 

3. On the Input Locales tab, click on Add… 

4. In the Add Input Locale dialog box, select the input locale and keyboard layout or IME you want to 

add. Click OK to exit. 

5. Repeat steps 3 and 4 to add more input languages. Once done, click OK to close Regional Options. 

6. You should now see a language indicator in the System Tray (located at bottom right hand corner of the 

desktop by default). You can switch between different input methods by pressing the left Alt + Shift keys 

or the right Alt + Shift keys 

B.3 Windows 98 and NT 

Under Windows 98, ME and NT it is possible to install Input Method Editors for Chinese (traditional or 

simplified), Japanese and Korean. Support for other complex script and right-to-left languages such as Arabic, 

Armenian, Georgian, Hebrew, the Indic languages, Thai, and Vietnamese is not possible. 

B.3.1 IMEs for East Asian Languages 

Microsoft provides the Global IME 5.02 for 32-bit Windows for East Asian languages that can be used 

under Windows 98-SE, ME and NT4-SP6, not using Office XP. 

1. Download the setup files for the IMEs including the Language Pack for Chinese (simplified or traditional), 

Japanese or Korean from http://www.microsoft.com/windows/ie/downloads/recommended/ime/install.asp 
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2. Run the setup and follow the instructions presented by the setup program. After the files are installed, 

you must restart your computer.  

The language only shows up in the language bar when a program has focus that supports the IME. 

After installation, documentation is provided in the Start menu, which is also accessible via the IME help 

button.  

Note: when Office XP is used under Windows 98, ME of NT, a different setup (Microsoft Global IME for 

Office XP) must be used. Please refer to 

http://www.microsoft.com/windows/ie/downloads/recommended/ime/default.asp. 

B.3.2 Additional languages and keyboard layouts 

Under Windows 98, ME and NT, additional languages and keyboard layouts can be configured via Keyboard 

in the Control Panel. 

Note that while IMEs for East Asian languages may have been installed in the previous step, these languages 

will not appear during this procedure. 

B.4 Windows Vista 

For installing East Asian language support under Windows Vista, please refer to 

http://newton.uor.edu/Departments%26Programs/AsianStudiesDept/Language/vista.html 

 

 



 

project: Error! Reference source not found. 

document name: WinIBW3 Product Description 

version: 2.3 

 

 

date: 2011-03-31 page 119 of 126 

 

Appendix C Unicode fonts  

In order to display all characters on the WinIBW3 Special Characters Bar, it may be necessary to install 

additional fonts. The base distribution of WinIBW3 does not supply Unicode fonts. 

The Arial Unicode MS font contains all characters used in the Special Characters Bar. This font is however 

not part of any Windows version, but is supplied with Microsoft Office 2000, FrontPage 2000, Office XP and 

Publisher 2002.  

Other free, shareware or commercial fonts may be available. An interesting resource for information about 

Unicode fonts is: http://www.alanwood.net/unicode/fonts.html 

C.2 Arial Unicode MS font 

The Arial Unicode MS font is installed as part of the Microsoft Office Setup and is part of the International 

Support features. To install the Arial Unicode MS font, follow these steps:  

1. Open the Control Panel. 

2. Click Add or Remove Programs.  

3. Do one of the following.  

• In Microsoft Windows 98, Microsoft Windows Millennium Edition (Me), or Microsoft Windows NT 

4.0:  

On the Install/Uninstall tab, click Microsoft Office XP (or Microsoft Word 2002), and then 

click Add/Remove. -or- 

• In Microsoft Windows 2000 or Microsoft Windows XP:  

Click Change or Remove Programs, click Microsoft Office XP (or Microsoft Word 2002), 

and then click Change. 

4. In the Features to install window, click Next.  

5. Click to expand Office Shared Features.  

6. Click to expand International Support.  

7. Click the icon next to Universal Font, and then click Run all from My computer on the 

shortcut menu.  

8. Click Update to complete the installation of the Universal Font (Arial Unicode MS) to your 

computer. 

Further information about the Arial Unicode MS Font can be found in the Microsoft Knowledge Base, article 

287247 

(http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/q287/2/4

7.asp&NoWebContent=1). 
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Appendix D Conversion Table Pica Characters To Unicode 

 
Pica 
hex 

Pica character name 
EN, NL, FR, DE 

Sym Unicode 
character 

Unicode  
character name 

a1 Polish L 
Grote Poolse L 
L barré majuscule 
polnisches L groß 

¡ &#x0141; Latin capital letter L with stroke 

a2 Danish O 
Grote Deense O 
O barré majuscule 
dänisches Ö groß 

¢ &#x00d8; Latin capital letter O with stroke 

a3 Servic D 
Grote Servische D 
D barré majuscule 
serbokroatisches D groß 

£ &#x0110; Latin capital letter D with stroke 

a4 Keltic P 
Grote Keltische P 
Thorn minuscule 
Thorn groß 

¤ &#x00de; Latin capital letter Thorn 

a5 ligature AE 
Grote ligatuur A E 
E dans l’A majuscule 
Ligatur AE groß 

¥ &#x00c6; Latin capital ligature AE 

a6 ligature OE 
Grote ligature O E 
E dans l’O majuscule 
Ligatur OE groß  

¦ &#x0152; Latin capital ligature OE 

a7 Cyrillic soft sign 
Zachtteken (tranlitt. 
Cyrillisch) 
Signe mou 
kyrillisches Weichheitszeichen 

§ &#x02b9; Modifier letter prime  

a8 Greek middle dot 
Half-hoge punt (Grieks) 
Point en haut (grec) 
griechischer halbhoher Punkt 

¨ &#x00b7; Middle dot 

a9 Mole 
Mol 
Bémol 
Mol 

© &#x266d; music flat sign 

aa registered sign 
Registratie-teken 
marque registrée 
registriertes Warenzeichen 

ª &#x00ae; Registered trade mark sign 

ab plus-minus sign 
Plusminus 
plus ou moins 
Plus-Minus 

« &#x00b1; Plus-minus sign 

ac Vietnamese O-hook 
Grote O-haak (Vietnamees) 
O barbu majuscule 
vietnamesischer O-Haken groß 

¬ &#x004f;&#x031b; Latin O with horn 

ad Vietnamese U-hook 
Grote U-haak (Vietnamees) 

- &#x0055;&#x031b; Latin U with horn 
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U Barbu majuscule 
vietnamesischer U-Haken groß 

ae Arabic hamza 
Alif 
Alif 
Hamzah 

® &#x02be; modifier letter right half ring 

af Angstrom A 
Grote Angstrom A 
A angstrom majuscule 
Angström A groß 

¯ &#x0041;&#x030a; Latin A with ring above 

b0 Arabic ain 
Ayn 
Ayn 
Ain 

° &#x02bf; modifier letter left half ring 

b1 Polish l 
Kleine Poolse l 
l barré minuscule 
polnisches l klein 

± &#x0142; Latin l with stroke 

b2 Danish o 
Kleine Deense o 
o barré minuscule 
dänisches ö klein 

² &#x00f8; Latin o with stroke 

b3 Servic d 
Kleine Servische d 
d barré minuscule 
serbokroatisches d klein 

³ &#x0111; Latin d with stroke 

b4 Keltic p 
Kleine Keltische p 
Thorn majuscule 
Thorn klein 

´ &#x00fe; Latin small letter Thorn 

b5 ligature ae 
Kleine ligatuur a e 
e dans l’a minuscule 
Ligatur ae klein 

µ &#x00e6; Latin small ligature ae 

b6 ligature oe 
Kleine ligatuur o e 
e dans l’o minuscule 
Ligatur oe klein 

¶ &#x0153; Latin small ligature oe 

b7 Cyrillic hard sign 
Hardteken (translitt. 
Cyrillisch) 
Signe Dur 
kyrillisches Härtezeichen 

· &#x02ba; modifier letter double prime 

b8 Turkish i 
Kleine Turkse i zonder punt 
i snas point minuscule 
türkisches i ohne Punkt klein 

¸ &#x0131; Latin dotless i 

b9 British pound 
Brits pond-teken 
Livre 
Pfund Sterling 

¹ &#x00a3; Pound sign 

ba Eth 
Kleine Eth 
Eth 
Eth 

º &#x00f0; Latin small letter eth 

bb Alpha 
Alpha 

» &#x03b1; Greek small letter alpha 
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Alpha 
Alpha 

bc Vietnamese o-hook 
Kleine o-haak (Vietnamees) 
o barbu minuscule 
vietnamesischer o-Haken klein 

¼ &#x006f;&#x031b; Latin o with horn 

bd Vietnamese u-hook 
Kleine u-haak (Vietnamees) 
u barbu minuscule 
vietnamesischer u-Haken klein 

½ &#x0075;&#x031b; Latin u with horn 

be Ringel-s 
Duitse dubbele s 
sz allemand minuscule 
deutsches ß 

¾ &#x00df; Latin small letter sharp s 

bf Angstrom a 
Kleine angstom a 
a-angström minuscule 
Angström a klein 

¿ &#x0061;&#x030a; Latin a with ring above 

c0 Dutch IJ 
Grote Nederlandse I J 
Digraphe IJ majuscule 
Niederländisches IJ groß 

À &#x0132; Latin ligature IJ 

c1 Umlaut A 
Grote umlaut A 
A-umlaut majuscule 
A-Umlaut groß 

Á &#x0041;&#x0308; Latin A with diaeresis 

c2 Umlaut O 
Grote umlaut O 
O-umlaut majuscule 
O-Umlaut groß 

Â &#x004f;&#x0308; Latin O with diaeresis 

c3 Umlaut U 
Grote umlaut U 
U-umlaut majuscule 
U-Umlaut groß 

Ã &#x0055;&#x0308; Latin U with diaeresis 

c4 Reversed C 
Grote omgekeerde C 
C renversé majuscule 
Umgekehrtes C groß 

Ä &#x0186; Latin capital letter open O 

c5 Reversed E 
Grote omgekeerde E 
E renversé majuscule 
Umgekehrtes E groß 

Å &#x018e; Latin capital letter reversed E 

c6 not equal to sign 
Ongelijk-teken 
Différent de 
Ungleich 

Æ &#x003d;&#x0338; is equal to sign COMBINING LONG 
SOLIDUS OVERLAY 

c7 Fleche 
Rechtse pijl 
Flèche 
Pfeil 

Ç &#x2192; rightwards arrow 

c8 less-than or equal to sign 
Kleiner dan/gelijk-teken 
Inférieur ou égal à 
Kleiner-Gleich 

≤ &#x2264; less-than or equal to sign 

c9 infinity sign 
Oneindig-teken 
Unendlich 

∞ &#x221e; infinity sign 
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Unendlich 
ca integral sign 

Integraal-teken 
Intégrale 
Integral 

Ê &#x222b; integral sign 

cb multiplication sign 
Vermenigvuldiging-teken 
Multiplié par 
Mal 

Ë &#x00d7; multiplication sign 

cc section sign 
Paragraaf 
Paragraphe 
Paragraph 

Ì &#x00a7; section sign 

cd square root 
Vierkantswortel-teken 
Racine 
Quadratwurzel 

Í &#x221a; square root 

ce Reaction 
Links rechts pijl 
Réaction 
Reaktion 

Î &#x21cb; Leftwards harpoon over rightwards 
harpoon 

cf greater-than or equal to sign 
Groter dan/gelijk teken 
Supérieur ou égal à 
Größer-Gleich 

Ï &#x2265; greater-than or equal to sign 

d0 Dutch ij 
Kleine Nederlandse i j 
Ligature ij minuscule 
niederländisches ij klein 

Ð &#x0133; Latin ligature ij 

d1 Umlaut a 
Kleine umlaut a 
a-umlaut minuscule 
a-Umlaut klein 

Ñ &#x0061;&#x0308; Latin a with diaeresis 

d2 Umlaut o 
Kleine umlaut o 
o-umlaut minuscule 
o-Umlaut klein 

Ò &#x006f;&#x0308; Latin o with diaeresis 

d3 Umlaut u 
Kleine umlaut u 
u-umlaut minuscule 
u-Umlaut klein 

Ó &#x0075;&#x0308; Latin u with diaeresis 

d4 Reversed c 
Kleine omgekeerde c 
c renversé minuscule 
umgekehrtes c klein 

Ô &#x0254; Latin small letter open o 

d5 Reversed e 
Kleine omgekeerde e 
e renversé minuscule 
umgekehrtes e klein 

Õ &#x01dd; Latin small letter turned e 

d6 Spanish inverted question 
mark 
Spaans omgekeerd vraagteken 
Point d’intérrogation renversé 
einleitendes Fragezeichen 

Ö &#x00bf; inverted question mark 

d7 Spanish inverted exclamation 
mark 
Spaans omgekeerd 

× &#x00a1; inverted exclamation mark 
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uitroepteken 
Point d’exclamation renversé 
einleitendes Ausrufungszeichen 

d8 Beta 
Beta 
Beta 
Beta 

Ø &#x03b2; Greek small letter beta 

d9 Euro 
Euro 
Euro 
Euro 

€ &#x20ac; Euro sign 

da Gamma 
Gamma 
Gamma 
Gamma 

Ú &#x03b3; Greek small letter gamma 

db Pi 
Pi 
Pi 
Pi 

Û &#x03c0; Greek small letter pi 

e0 Vietnamese tone mark 
Rijzende toon (Vietnamees) 
Barbe vietnamienne 
Tonanstieg vietnamesisch 

à &#x0309; combining hook above 

e1 accent grave 
Grave 
Accent grave 
Gravis 

á &#x0300; combining grave accent 

e2 accent aigu 
Aigu 
Accent aigu 
Akut 

â &#x0301; combining acute accent 

e3 accent circonflexe 
Circumflex 
Accent circonflexe 
Zircumflex 

ã &#x0302; combining circumflex 

e4 Tilde 
Tilde 
Tilde 
Tilde 

ä &#x0303; combining tilde 

e5 Overline long 
Bovenstreepje (lang) 
Macron 
Balken 

å &#x0304; combining macron 

e6 Overline short 
Bovenstreepje (kort) 
Demi-cercle suscrit 
Halbkreis übergesetzt 

æ &#x0306; combining breve 

e7 Period above 
Punt als accent (bovenaan) 
Point suscrit 
Punkt übergesetzt 

ç &#x0307; combining dot above 

e8 diaeresis 
Trema 
Tréma 
Trema 

è &#x034f;&#x0308; combining grapheme joiner 
combining diaeresis 

e9 Hacek 
Hacek 

é &#x030c; combining caron 
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Hacek 
Hacek 

ea Angstrom 
Cirkeltje 
Cercle suscrit 
Ringel untergesetzt 

ê &#x00b0; degree sign 

eb Ligature left 
Ligatuur links 
Ligature 2 
Ligatur links 

ë &#xfe20; combining ligature left half 

ec Ligature right 
Ligatuur rechts 
Ligature 1 
Ligatur rechts 

ì &#xfe21; combining ligature right half 

ed Comma above 
Comma als accent (bovenaan) 
Virgule suscrite centrée 
Komma als Akzent oben 

í &#x0315; combining comma above 

ee Double aigu 
Dubbele aigu 
Accent aigu double 
Doppel-Akut 

î &#x030b; combining double acute accent 

ef candrabindu 
Candrabindu 
Candrabindu 
Candrabindu 

ï &#x0310; combining candrabindu 

f0 cedilla 
Cedille 
Cedille 
Cedille 

ð &#x0327; combining cedilla 

f1 Hook upper left 
Haak boven links 
Crochet droit 
Haken oben links 

ñ &#x0328; combining ogonek 

f2 Combining period 
Punt als accent 
Point souscrit 
Punkt untergesetzt 

ò &#x0323; combining dot below 

f3 Combining double period 
Twee punten als accent 
Deux point souscrits 
2 Punkte untergesetzt 

ó &#x0324; combining diaeresis below 

f4 Ring below 
Cirkeltje onderaan 
Cercle souscrit 
Ringel untergesetzt 

ô &#x0325; combining ring below 

f5 Double underlining 
Dubbele onderstreping als 
accent 
Double souligné 
doppelter Unterstrich 

õ &#x0333; combining double low line 

f6 Single underlining 
Onderstreping als accent 
Souligné 
Unterstrich 

ö &#x0331; combining macron below 

f7 Hook upper right 
Haak boven rechts 

÷ &#x0326; combining comma below 



 

project: Error! Reference source not found. 

document name: WinIBW3 Product Description 

version: 2.3 

 

 

date: 2011-03-31 page 126 of 126 

 

Crochet gauche 
Haken oben rechts 

f8 Inverted cedilla 
Omgekeerde cedille 
Esprit rude 
Cedille rude 

ø &#x031c; combining left half ring below 

f9 Upadhmaniya 
Upadhmaniya 
Demi-cercle souscrit 
Upadhmaniya 

ù &#x032e; combining breve below 

fa Half tilde right 
Halve tilde rechts 
Demie-tilde droite 
halbe Tilde rechts 

ú &#xfe23; combining double tilde right half 

fb Half tilde left 
Halve tilde links 
Demie-tilde gauche 
halbe Tilde links 

û &#xfe22; combining double tilde left half 

fe Comma right middle 
Comma rechts (op 
middelhoogte) 
Virgule suscrite décentrée 
Komma rechts mittelhoch 

þ &#x0313; combining comma above right 

 

 


